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Preface

The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available
on your network from which you can access the Agile PLM documentation (PDF) files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later.
This program can be downloaded from the Adobe Web site http://www.adobe.com.

The Oracle Technology Network (OTN) Web site
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help >
Manuals in both Agile Web Client and Agile JavaClient. If you need additional assistance or
information, please contact My Oracle Support (https://support.oracle.com) for assistance.

Note  Before calling Oracle Support about a problem with an Agile PLM manual, please have
the full part number, which is located on the title page.
TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398.
Outside the United States, call +1.407.458.2479.

Readme

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids

Go to the Oracle University Web page
http://www.oracle.com/education/chooser/selectcountry _new.html for more information on Agile
Training offerings.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line;
however, some screen readers may not always read a line of text that consists solely of a bracket or
brace.

This documentation may contain links to Web sites of other companies or organizations that Oracle
does not own or control. Oracle neither evaluates nor makes any representations regarding the
accessibility of these Web sites.
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Chapter 1
Product Quality Management

This chapter includes the following:

B BEfOrE YOU BEUIN ..ottt bbb bbbt 1
m What's NEW N PQM 9.3ttt 1
= An Overview of Product Quality Management............ccovrnnine e 2
5 ProdUCt SEIVICE REQUESES .......vuieiieeeiricies ettt sttt eene e 2
® QUAlity ChanGge REGUESES........cuuiuirieiie ittt bbb 3

TrACKING QUANIEY ... cv.cvevecietiei ettt 4

Before you Begin

This manual guides you to use Agile Product Quality Management solution provided you have
installed Agile PLM at your company. To install Agile PLM, use the appropriate installation
documentation. To help you install Agile PLM and understand Agile objects, classes, their
application and their working, refer the manuals listed below:

o Agile Database Installation Guide
o Installing Agile PLM for OAS

= Installing Agile PLM for WebLogic
o Getting Started with Agile PLM

o Agile PLM Administrator Guide

For details about common terms appearing across all Agile PLM modules, see the Getting Started
with Agile PLM guide.

What's New in PQM 9.3

Changes across Agile PLM 9.3 User Interface have created a few changes in the PQM module as
well. Listed below are generic enhanced features and links, which lead you to detailed
documentation on some of the commonly used features of PQM.

Enhanced generic features across Agile PLM:

o Preview pane replaced by Quick View: The Quick View dialog appears when you position the
cursor on an object. It gives you the object details and allows you to perform a few actions.

o Enhanced Add feature allows you to add/remove objects faster by either drag and drop option
or the copy and paste option.

o Views and Personalize menu replace the filter option in the Web Client. See also: Relationships
Table on page 39.

= The Edit Rule button is now available on the Relationships table and the Quick View dialog.
Commonly used features in Agile PQM:

o Creating a PSR from an ltem: Icon changes. Views and Personalize menu replaces the filter option
in the Web Client.

v9.3.0.2 1
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o Search for PSRs and QCRs: The Execute a Quick Search, Custom Search and the Advanced
Search results returns PSRs or QCRs matching the set criteria. For details, see Search for

PSRs or QCRs on page 21.

o Creating PSR using Save As: Additional features now allow you to reference existing files, create
new copies of the file or does not include files, when you copy PSRs with Attachments. See
Step 5 of the instructions of Creating PSR using Save As on page 20.

o Create a QCR from a PSR: Icon changes. Views and Personalize menu replace the filter option in
Web Client.

o Adding ltems to the Affected Items tab of a PSR: You can add items to the Affected Items tab of a
PSR using the Search/Create Button. See Search to add on page 28 to search for existing
Items and Create to add on page 28 to create new Items. Adding objects is now made faster
by using the drag/drop option, and the copy/paste option. See also: Adding Items to the
Affected Items tab of a PSR on page 28.

= Adding Objects to the Relationships tab of a PSR: Enhanced add features, the appearance of the
Edit Rule on the Relationships table and also in the Quick View dialog message bar. See also:
Adding Objects to the Relationships tab of a PSR on page 40.
Adding Relationship Rules on page 43. Editing Relationship Rules on page 44.

= Viewing Quality issues against a Customer or Supplier: Enhanced search results help you view
Quality issues on PSRs, QCRs, Customers and Suppliers.
See also Viewing Quality issues against a Customer or Supplier on page 15.

An Overview of Product Quality Management

Agile PQM is a powerful solution currently in use across leading business organizations around the
globe. It involves an innovative methodology used to track and manage data, which translates to
(better products) enhanced quality, productivity (lesser time cycles) and reliability (Zero failures).
The flexibility of the solution adds to its inclusion across a number of business ventures. This
includes customer complaints, product and manufacturing defects, field failures, enhancement, and
corrective and preventive measures. Agile PQM closes the support loop by unifying the company’s
customer service; field sales, manufacturing, and engineering organizations, and linking the
company to its customers and partners.

As alternate quality management packages enter the market, customers demand quality products at
a lower cost, and a reduced product lifecycle. Quality incidents reported by the customers help you
detect defects and resolve them responsively. Tracking defects and finding the root cause of the
defects in a timely manner are keys to effective defect reduction and improving product quality.

The Agile PQM solution includes Product Service Requests (PSRs) and Quality Change Requests
(QCRs). PSRs manage Problem Reports and Non-Conformance Reports. QCRs create and
manage Audits, and Corrective and Preventive Actions (CAPAS).

Product Service Requests

Product Service Requests report quality incidents, and aggregate a number of other PSRs to a single
PSR. The PSR class includes Problem Reports (PRs) and Non-Conformance Reports (NCRs). PRs
report generic quality incidents and NCRs report material deviations from specifications and other
specific quality issues. For details, see Working with Product Service Requests on page 17.

2 Agile Product Lifecycle Management
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Problem Reports

A Problem Report contains a basic description of a quality issue, problem, or incident reported from a
customer’s perspective. A customer, field service representative, or supplier may submit a Problem
Report provided they hold the appropriate privilege to process a Problem Report. You need to route
a Problem Report for inquiry through a workflow. The inquiry team determines the root cause of the
problem. The user with Quality Analyst role oversees the processing of the problem reports.

You use Agile Import or Agile SDK to import problem reports from different CRM systems.

Non-Conformance Reports

A customer, field service representative, or supplier may submit a Non-Conformance Report (NCR) to
report a basic material deviation from specifications or requirements in one or more products. You
also need to route Non-Conformance Reports through a workflow for an inquiry.

Incoming inspection lots or testing processes use an NCR and the Quality Analyst checks samples
for deviations from specifications.

Quality Change Requests

Quality Change Requests creates and manages Audits and Corrective and Preventive Actions
(CAPASs). An audit is the pro-active process of verifying compliance with quality requirements. The
CAPA is a formal process of addressing any generic quality problems and analyzing the root cause
S0 you can implement corrective and preventive actions.

QCRs allow you to aggregate problems into a routable quality record, perform root-cause failure
analysis, and drive the problems to closure using standard CAPA (corrective and preventive
actions) procedures. The CAPA may result in changes to a product, process, or supplier.

You can use QCRs to:

1. Create and manage quality records that aggregate problems related to products, documents,
suppliers, and customers.

2. Provide a means for driving quality-related changes by creating changes such as ECOs,
MCOs, ECRs, stop ships, and deviations.

3. Route change requests for review and approval, thereby enabling communication and
collaboration between the originator (Quality Control), root-cause failure analysis (Quality
Control and Engineering), resolution (Engineering), corrective/preventative action (Quality
Management), communication (customers and suppliers) and verification (compliance/audit).

4. Provide an audit trail between problems, corrective and preventive actions, and engineering
changes that enable internal and external compliance processes.

For example, while conducting a quality check on the incoming lot of items from your supplier, you
identify a defective item. To take corrective action, you create a QCR for the defective item and route
it for review and approval. You can route the item through a change to ensure rectification of the
defect and check for the latest revision of the item.

For more details, see Working with Quality Service Requests on page 49.

Audits

An Audit is a pro-active process of verifying compliance with quality requirements. Default Audit
workflows are different from CAPA workflows. For details, see Workflow tab of a QCR on page 57.

v9.3.0.2 3
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Corrective and Preventive Actions

Corrective and preventive actions (CAPAs) address generic quality problems for one or more PSRs.
A CAPA could result in the creation of one or more changes that lead to fixing the problems. A
CAPA is a routable object and a workflow controls it. CAPA workflows vary for different workflow
statuses. For details, see Workflow tab of a QCR.

Tracking Quality

Tracking quality helps organizations identify, measure and improve business processes, which in
turn leads to improved business performance and thus assures customer satisfaction. Monitoring
non-conformance reports and implementing CAPAs help organizations meet standards. We look at
some of the quality features that enable us to meet these standards.

Tracking Quality Roles

Product Quality Management provides these roles:

Quality Analyst — The role of a Quality Analyst allows you to submit Problem Reports (PRs) and Non-
Conformance Reports (NCRs) and manage their resolution.

Quality Administrator — The role of a Quality Administrator allows you to manage Audits and CAPASs.
For details about Agile PLM roles, see the Agile PLM Administrator guide.

Tracking Quality Process

The following diagram illustrates an example of a quality incident process. Following the diagram is
a description of each numbered step.

Quality Tracking Process

1 3 Problem escalation process
Customer1 /—*’ PSRA
PSR 2 \‘
Start Here 3 4 Create Change
/‘ PSR4 |T ™| QCR1 [T ® ECR

1 2
. ECO
PSR 2 |
10 9 Problem closure process
Customer 1 ~ PSR A
PSR 2

5

Change is routed
and released

[
Finizh Here 8 7 i
f— — Change is
3 / PSR4 QCcRA1 complete
10
-— PSRA1
Customer 2 PSR 2

Two customers report quality incidents. Customer 1 and Customer 2

1.
2. The support division creates problem service requests (PSRs) for the reported incidents.
3. PSR-1, PSR-2, PSR-3 for Customer 1.
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PSR-1, PSR-2, PSR-3 for Customer 2.
4. Submits PSRs to the Quality Analyst, who reviews all the PSRs.

5. Since all PSRs pertain to similar incidents even though they are from different customers, the
Quality Analyst aggregates them to a single PSR and creates PSR-4.

6. For further processing, routes PSR-4 through a workflow.

7. The Quality Administrator creates a quality change request, QCR-1. The QCR includes a list of
the items that it affects.

8. Routes the QCR.

9. The engineering team determines if the request is valid and merits a change (an ECO, MCO,
and ECR, stop ship or deviation depending on the problem).

10. Create a change to address the problem. The Change Analyst routes the change through the
workflow.

11. Changes implemented fix the problem. The Change Analyst sends a notification to the Quality
Administrator, who checks if the change did address the problem documented in the QCR.

12. The quality administrator takes action to close the QCR.

Quality Related SmartRules

SmartRules are system wide settings that let you choose how to manage specific behaviors in Agile
PLM. Agile Administrator can modify these settings. The following SmartRules relate to Product
Quality Management processes:

@ Many Iltems per PSR

= Many QCRs per PSR

o PSR contains Items and Related PSRs
o Release QCR with resolved Items.

We take the example of PSR contains Items and Related PSRs SmartRule.

The PSR contains Items and Related PSRs SmartRule controls the behavior of the Affected Iltems
tab and the Related PSR tab of PSRs. If you set the SmartRule to Allow, PSRs can have both
affected items and related PSRs. Otherwise, both Affected Items and related PSRs are mutually
exclusive. In other words, if the Affected Iltems tab lists items, then the Related PSR tab is
unavailable; and if Related PSR tab lists PSRs, then the Affected Items tab is unavailable. This
allows you to choose whether to use a PSR as an aggregation of other PSRs or as a problem report
against assembly items.

For complete details on these and other SmartRules, see the Agile PLM Administrator guide.

Quality Searches

You can perform a search by selecting the required search from either the Quick Search or
Advanced Search from the Quality Searches folder to find specific PSRs and QCRs. For example, if
you are a Quality Administrator and need to assign all unassigned PSRs to Quality Analysts, you
can do a quick search of all unassigned PSRs. Listed below are some of the sample quality
searches:

= Unassigned PSRs

o Open PSRs

= PSRs submitted more than X hours ago
o QCRs submitted more than X hours ago

v9.3.0.2 5
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@ Released QCRs

o Closed QCRs

= Unassigned Submitted QCRs
= Open QCRs

Note  The Quality Searches folder appears only if the Administrator has specified the searches
in your profile.

Quality Reports
Agile PLM provides several standard reports that help you analyze data in Agile PQM.

In the navigation pane of the Agile Web Client, click Reports > Reports and Analytics > Standard Reports
> Quality Reports. The Quality Reports lists the following reports:

o Failure Trend Report on page 6

B Quality Activity Report on page 8

B Quality Backlog Report on page 10
B Quality Cycle Time Report on page 11

B Quality Metrics Report on page 13

Each of the above Reports takes you through a Report Wizard provided you hold the necessary
privileges. Step through the wizard. At the end of the process a Report appears. You can print the
report, export its content, or save it. Executed report outputs are visible only in Web Client.

A Quality Report consists of the following tabs:

General info - gives you the general details about the report. The Agile administrator sets the fields
on the General info tab.

Layout tab: In the Layout tab, you can add or edit fields in a standard or customized report layout, if
required. You need appropriate privileges to edit the layout.

Schedule: The Schedule tab allows you to run a report using a specific schedule, or on specific date
and time.

Historical Report: The Historical Report tab displays all previously run reports. It displays saved
reports with the date, time and the name of the user who runs the report.

History: The History tab shows a summary of actions taken on the report.

For more details on the tabs of Quality Reports, see the Getting Started with Agile PLM guide.
Failure Trend Report

The Failure Trend Report lists trends in failure mode over time. Based on the results, you can focus
corrective efforts on those items that have the greatest effect on product quality.

To produce a report of the quantities affected during the specified period, Product Service Requests
must have a value specified in the Affected Items Quantity Affected field. Ensure to obtain the
necessary privileges to execute a report.

To run a Failure Report Trend:

1. Inthe navigation pane, navigate to Reports > Reports and Analytics > Standard Reports > Quality
Reports > Failure Trend Report.

6 Agile Product Lifecycle Management
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8.

9.

Click the Execute button. A Run Failure Trend Report wizard opens.
In the Select Layout and Configuration page, select a Layout from the list.

a. Click the Edit £ button to modify an existing layout. The Default Layout dialog opens.
Modify the required fields.

b. Select properties from the Hidden Fields column and move them to the Displayed Fields
column using the right arrow. You can also place them in the required ascending or
descending order using arrows.

c. Click Save to save the changes or Close to close the palette.
In the Properties frame,

a. Enter a name in the Name field.

Select the type of Access.

Select the Paper Size from the list.

Select the Orientation of the paper.

Click Save to save the changes or Close to close the palette.

® o0 o

#
Click the Create d button to create a new layout. The Layout Presentation palette opens.
In the Format frame,

a. Select properties from the Hidden Fields column and move them to the Displayed Fields
column using the right arrow. Place them in the required ascending or descending order
using arrows.

b. Click Save to save the changes or Close to close the palette.
In the Properties frame,

a. Enter a name in the Name field.

Select the type of Access.

Select the Paper Size from the list.

Select the Orientation of the paper.

Click Save to save the changes or Close to close the palette.

Select a format for the generated report from the Output Format list. Choose from a list of
formats - PDF, WORD, EXCEL, HTML, and STANDARD.

Select the Save a copy of the report in the historical reports check box to save the generated report.

®oo00o

Note  The Save a copy of the report in the historical reports check box does not appear if you select

the Standard output format.

10. Click Next.
11. The Select or Create a Query page appears. The Failure Trend Report lets you search for

Product Service Requests to use in the report.
a. Select the All Product Service Requests check box to choose from all the PSRs.
Select the Saved Search check box to choose from existing PSRs.

Click the Search = palette and choose a value from the Saved Searches list.
Select the Advanced Search check box.

Click Define Query. A Report Search palette opens. Choose from the list or enter the
necessary details to define the query.

f.  Click Clear to clear the selection, Finish to continue and Close to close the palette.

® oo o
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Note  For details about the Search palette, see the Getting Started with Agile PLM guide.

12. Click Next to proceed to the next step or Back to edit the Query.
13. The Define Report page appears.
In the Time Period frame,
a. Click the calendar and select a From date.
b. Click the calendar and select a To date.
c. Select a Time Unit from the list.
14. In the Additional Report Criteria frame,
a. Select a value from the Trend By list.
b. Select the check box to display the Product Service Requests.
c. Select the check box to Exclude Empty Columns.
15. Click Finish to display the report.
16. A Get Attachment dialog prompts you to download the report.

Click the buttons that appear at the top of the generated report to save, print, or export the report.
The report is lost if you click the Close button, without saving it.

Save: Saves the report to the Historical Report tab.
Print: Prints the generated report.

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook.

Quality Activity Report

The Quality Activity report lists quality incidents (product service requests and quality change
requests) processed during a specified period.

To run a Quality Activity Report:

1. Inthe navigation pane, navigate to Reports > Reports and Analytics > Standard Reports > Quality
Reports > Quality Activity Report.

Note  For details on how to run the report, see the chapter 'Working with Reports' in the
Getting Started with Agile PLM guide.

2. Click Execute. A Run Quality Activity Report wizard opens.
3. Inthe Select Layout and Configuration page, select a Layout from the list.

4. Click the Edit £ button to modify an existing layout. The Default Layout For PSR palette
opens. Modify required fields.

5. In the Format frame,

a. Select properties from Hidden Fields column and move them to Displayed Fields column using
the right arrow. You can also place them in the required ascending or descending order
using arrows.

b. Click Save to save the changes or Close to close the palette.
6. Inthe Properties frame,

a. Enter a name in the Name field.

b. Select the type of Access.

c. Select the Paper Size from the list.

8 Agile Product Lifecycle Management
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10.

11.

12.
13.

14.
15.

16.

o

Select the Orientation of the paper.

Select the Layout Type.

Select the View in format of the report.

Click Save to save the changes or Close to close the palette

a0}

#
Click the Create il button to create a new layout. The Layout Presentation palette appears.
In the Format frame:

a. Select properties from Hidden Fields column and move them to Displayed Fields column using
the right arrow. Place them in the required ascending or descending order using arrows.

b. Click Save to save the changes or Close to close the palette.
In the Properties frame,

a. Enter a name in the Name field.

Select the type of Access.

Select the Paper Size from the list.

Select the Orientation of the paper.

Select a Layout Type.

Select the View in format for the report.

g. Click Save to save the changes or Close to close the palette.

Select a format for the generated report from the Output Format list. Choose from a list of
formats - PDF, WORD, EXCEL, HTML, and STANDARD.

Select the Save a copy of the report in the historical reports check box to save the generated report.

~®ao0o0o

Note  The Save a copy of the report in the historical reports check box does not appear if you
choose the Standard output format.

Click Next.

The Select Date Range page appears.

a. Click the calendar and select a From date.

b. Click the calendar and select a To date to show the time covered.
Click Next.

The Select Additional Parameters page appears. In the Workflow and Status Change Criteria
frame,

a. Select a workflow from the Workflow Type list.

b. Click the Search S palette to effect a change in the Status Changes to field. A Change
palette appears. Select and double-click the item to move it to the Status Changes to field.

c. Click Finish to display the report.

A Get Attachment dialog prompts you to download the report.

Click the buttons that appear at the top of the generated report to save, print, or export the
report. The report is lost if you click the Close button without saving it.

Save: Saves the report to the Historical Report tab.

Print: Prints the generated report.

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook.
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Quality Backlog Report

The Quality Backlog Report lists incidents that are at a specified status but have not moved to the
next status during a specified period.

To run a Quality Backlog Report:

1. Inthe navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports >

Quality Backlog Report.

2. Click the Execute button. A Quality Backlog Report wizard opens.
3. Inthe Select Layout Configuration page, select a Layout from the list.

a. Click the Edit £ button to modify an existing layout. The Default Layout palette opens.
Modify required fields.

b. Select properties from the Hidden Fields column and move them to the Displayed Fields
column using the right arrow. Place them in the required ascending or descending order
using arrows.

c. Click Save to save the changes or Close to close the palette.

4. Inthe Properties frame,

a. Enter a name in the Name field.

b. Select the type of Access.

c. Select the Paper Size from the list.

d. Select the Orientation of the paper.

e. Select a Layout Type.

f.  Select a Select properties from the Hidden Fields column and move them to the Displayed
Fields column using the right arrow. Place them in the required ascending or descending
order using arrows.

g. Click Save to save the changes or Close to close the palette.

5. Click the Create a button to create a new layout. The Layout Presentation palette opens.
6. Inthe Format frame,

a. Select properties from the Hidden Fields column and move them to the Displayed Fields
column using the right arrow. Place them in the required ascending or descending order
using arrows.

b. Click Save to save the changes or Close to close the palette.

7. Inthe Properties frame,

a. Enter a name in the Name field.

b. Select the type of Access.

c. Select the Paper Size from the list.

d. Select the Orientation of the paper.

e. Select a Layout Type.

f.  Select a View in format for the report.

g. Click Save to save the changes or Close to close the palette.

8. Select a format for the generated report from the Output Format list. Choose from a list of
formats - PDF, WORD, EXCEL, HTML, and STANDARD.

9. Select the Save a copy of the report in the historical reports check box to save the generated report.
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Note  The Save a copy of the report in the historical report check box does not appear if you
select the Standard output format.

10. Click Next.

11. The Select or Create a Query frame appears. The Quality Backlog Report lets you search for
Product Service Requests to use in the report.

a. Select the All Product Service Requests check box to choose from all the PSRs.
b. Select the Saved Search check box.

c. Click the Search s palette and choose a value from the saved Searches list.
d. Select the Advanced Search check box.
12. Click Define Query. A Report Search palette opens.
a. Choose from the list or enter the necessary details to define the query.
b. Click Clear to clear the selection, Finish to continue and Close to close the palette.

13. Click Next to proceed to the next step or Back to modify the Query. The Define Report frame
appears.

14. In the Time Period frame,
a. Use the calendar to select a From date.
b. Use the calendar to select a To date.
c. Choose a Time Unit from the list.
15. In the Status Change frame,
a. Select a workflow from the Workflow list.
b. Select a Starting Status.
c. Select a To status.
16. In the Additional Report Criteria frame,
a. Select a value from the Trend By list.
b. Select the check box to display the Product Service Requests.
c. Select the check box to Exclude Empty Columns.
17. Click Finish to display the report.
18. A Get Attachment dialog prompts you to download the report.

Click the buttons that appear at the top of the generated report to save, print, or export the report.
The report is lost if you click the Close button without saving it.

Save: Saves the report to the Historical Report tab.
Print: Prints the generated report.

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook.

Quality Cycle Time Report

The Quality Cycle Time Report calculates the time it takes for the specified product service requests
and quality change requests (PSRs and QCRs) to move to another status in a specified period.

The report lists the requests and shows the average time each PSR or QCR takes between two
statuses. For example, the report indicates the average time it took for a PSR or QCR to go from
Submitted to Released each month during the last year, grouped by a product line.
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To run a Quality Cycle Time Report:

1. Inthe navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports >
Quality Cycle Time Report.

2. Click Execute. A Quality Cycle Time Report wizard appears.
3. Inthe Select Layout and Configuration page, select a Layout from the list.

4. Click the Edit £ button to modify an existing layout. The Default Layout dialog opens.
Modify the required fields.

In the Format frame,

a. Select properties from the Hidden Fields column and move them to the Displayed Fields
column using the right arrow. Place them in the required ascending or descending order
using arrows.

b. Click Save to save the changes or Close to close the palette.
5. Inthe Properties frame,
a. Enter a name in the Name field.
Select the type of Access.
Select the Paper Size from the list.
Select the Orientation of the paper.
Select a Layout Type.
Select a View in format for the report.
Click Save to save the changes or Close to close the palette.

@ ~0o ooy

#*
6. Alternately, click the Create 'J button to create a new layout. The Layout Presentation palette
opens.

7. Inthe Format frame,

a. Select properties from the Hidden Properties column and move them to the Displayed
Properties column using the right arrow. Place them in the required ascending or
descending order using arrows.

b. Click Save.
8. Inthe Properties frame,
a. Enter a name in the Name field.
Select the type of Access.
Select the Paper Size from the list.
Select the Orientation of the paper.
Select a Layout Type.
Select a View in format for the report.
Click Save to save the changes and Close to close the palette.

9. Select a format for the generated report from the Output Format list. Choose from a list of
formats - PDF, WORD, EXCEL, HTML, and STANDARD.

10. Select the Save a copy of the report in the historical reports check box to save the generated report.

-0 Qoo0C

Note  The Save a copy of the report in the historical reports check box does not appear if you
select the Standard Output Format.

11. Click Next.
12. The Select or Create a Query page appears. The Quality Cycle Time Report lets you search for
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Product Service Requests to use in the report.
a. Select the All Product Service Requests check box to choose from all the PSRs.
b. Select the Saved Search check box.

c. Click the Search = palette and choose a value from the Saved Searches list.
d. Select the Advanced Search check box.
13. Click Define Query. A Report Search palette opens.
a. Choose from the list or enter the necessary details to define the query.
b. Click Clear to clear the selection, Finish to continue and Close to close the palette.

14. Click Next to proceed to the next step or Back to modify the Query. The Select or create a Query
page appears.

15. In the Time Period frame,
a. Use the calendar to select a From date.
b. Use the calendar to select a To date.
c. Choose a Time Unit from the list.
16. In the Status Change frame,
a. Select a workflow from the Workflow list.
b. Select a Starting Status.
c. Select a To Status
17. In the Additional Report Criteria frame,
a. Select a value from the Trend By list.
b. Select the check box to display the Product Service Requests.
c. Select the check box to Exclude Empty Columns.
18. Click Finish to display the report.
19. A Get Attachment dialog prompts you to download the report.

Click the buttons that appear at the top of the generated report to save, print or export the report.
The report is lost if you click the Close button without saving it.

Save: Saves the report to the Historical Report tab.
Print: Prints the generated report.

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook.

Quality Metrics Report

The Quality Metrics Report shows quality incidents (product service requests and quality change
requests) that moved to a specified status during a specified period.
To run a Quality Metrics Report:

1. Inthe navigation pane, go to Reports > Reports and Analytics > Standard Reports > Quality Reports >
Quality Metrics Report.

2. Click Execute. The Quality Metrics Report wizard appears.
3. From the Select Layout and Configuration page, select a Layout from the list.

4. Click the Edit £ button to modify an existing layout. The Default Layout dialog opens.
Modify the required fields.

a. Select properties from the Hidden Fields column and move them to the Displayed Fields
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column using the right arrow. Place them in the required ascending or descending order
using arrows.

b. Click Save to save the changes or Close to close the palette.
5. Inthe Properties frame,
a. Enter a name in the Name field.
Select the type of Access.
Select the Paper Size from the list.
Select the Orientation of the paper.
Select a Layout Type.
Select a View in format for the report.
Click Save to save the changes or Close to close the palette.

-0 oo0C

#
6. Alternately, click the Create 4 button to create a new layout. The Layout Presentation palette
opens.

7. Inthe Format frame,

a. Select properties from the Hidden Properties column and move them to the Displayed
Properties column using the right arrow. Place them in the required ascending or
descending order using arrows.

b. Click Save to save the changes and Close to close the palette.
8. Inthe Properties frame,
a. Enter a name in the Name field.
Select the type of Access.
Select the Paper Size from the list.
Select the Orientation of the paper.
Select a Layout Type.
Select a View in format for the report.
g. Click Save to save the changes and Close to close the palette.

9. Select a format for the generated report from the Output Format list. Choose from a list of
formats - PDF, WORD, EXCEL, HTML, and STANDARD.

10. Select the Save a copy of the report in the historical reports check box to save the generated report.

~®aoo0C

Note  The Save a copy of the report in the historical reports check box does not appear if you
select the Standard output format

11. Click Next.

The Select or Create a Query page appears. The Quality Metrics Report lets you search for
Product Service Requests to use in the report.

® Select the All Product Service Requests check box to choose from all the PSRs.
® Select the Saved Search check box.
®  Click the Search = palette and choose a value from the list of Saved Searches.
® Select the Advanced Search check box.
12. Click Define Query. A Report Search palette opens.
a. Choose from the list or enter the necessary details to define the query.
b. Click Clear to clear the selection, Finish to continue and Close to close the palette.
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13. Click Next to proceed to the next step or Back to edit the Query. The Define Reports page
appears.

14. In the Time Period frame,
a. Use the calendar to select a From date.
b. Use the calendar to select a To date.
c. Choose a Time Unit from the list.
15. In the Status Change frame,
a. Select a workflow from the Workflow list.
b. Select a status from the Status Type.
16. In the Additional Report Criteria frame,
a. Select a value from the Trend By list.
b. Select the check box to display the Product Service Requests.
c. Select the check box to Exclude Empty Columns.
17. Click Finish to display the report.
18. A Get Attachment dialog prompts you to download the report.

Click the buttons that appear at the top of the generated report to save, print, or export the report.
The report is lost if you click the Close button without saving it.

Save: Saves the report to the Historical Report tab.
Print: Prints the generated report.

Export: Exports the content of the report to a delimited text file (CSV) or a Microsoft Excel workbook.

Quality Tracking Tabs

You can link Quality information on certain tabs and fields with information about objects such as
items, customers, and suppliers. The organization can then assess the quality risk of incorporating
certain parts into their designs.

* The Quality tab for items displays all PSRs reported against that item.

®* The PSRs tab of a Customer object lists all quality incidents reported by the customer.
This helps you gauge customer satisfaction.

®* The PSRs tab of a Supplier object lists all quality incidents filed against the supplier. This
can affect purchasing by helping you gauge the quality performance of a supplier so that
you can establish a rating or preference for that supplier.

Viewing Quality Issues against Customers and Suppliers

Listed below are a number of ways you can view Quality issues against Customers or Suppliers.

o Execute a Quick Search - Fastest way to find PSRs, QCRs, Customers, and Suppliers on the
Home Page.

o Custom Search - A combination of different queries returns PSRs with matching criteria. For
example, Product Service Requests: Customer is not Null OR Supplier is not Null.

o Advanced Search - Most effective way of finding objects setting multiple criteria and filtering down
on objects. For example,
Items with PSRs of Customer/Suppliers, which have QCRs initiated.
Items only have PSRS for Customers/Suppliers but QCR is not initiated.
Items having PSRs & QCRs and Changes associated with them.
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View Parts - The Quality tab of Parts displays the PSR & QCR numbers along with Customer
and Supplier details

Search Personalization - Format a search and choose the required View by using the Personalize
menu. For example, View all the QCRs/PSRs for Customers and Suppliers in displayed fields.
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Chapter 2
Working with Product Service Requests

This chapter includes the following topics:
& Creating Product Service Requests on page 17

o Cover Page tab of a PSR on page 21

B Affected Items tab of a PSR on page 26
o Related PSR tab on page 30

B Relationships tab on page 35

& Workflow tab of a PSR on page 45

= Attachments tab of a PSR on page 47

B Submitting and Routing PSRs on page 46

Creating PSRs

Creating Product Service Requests (PSR) depends on the quality of the incidents. They can either
report a single quality incident or multiple incidents with a single PSR. It is mandatory that you have
the necessary roles and privileges to create PSRs. For details on Roles and Privileges, see the
Getting Started with Agile PLM guide.

Note  The role of a Quality Analyst allows you to create, edit, delete, and perform all the
necessary actions on PSRs.

Creating a Product Service Request

The Create New feature on the Home page allows you to create a PSR.

To create a PSR in Java Client:
1. Launch Agile Java Client.
2. On the main toolbar, click File > New > Product Service Requests > Problem Reports.
3. Inthe New dialog that appears,
a. Choose the required sub-class (NCR or Problem Report) from the Type list.

b. In the Number field, accept the default number, enter a number, or click the Autonumber A
button to generate a new number.

c. Choose a Quality Analyst from the list.
4. Click OK.

Agile Java Client creates a PSR and displays it with the Cover Page in the edit mode.
For more information about the cover page, see Cover Page tab of a PSR

To create a PSR in Agile Web Client:

1. Launch Agile Web Client.

2. On the main toolbar click the Create New menu.

3. Select Product Service Requests> Problem Report or Non-Conformance Report from the drop-down
menu. The Create New dialog appears.
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4. Select a required subclass (NCR or Problem Report) from the Type list.

5. In the PSR Number field, accept the default number, enter a number, or click the Autonumber

122 putton to generate a new number.

6. Click Save.
The Agile Web Client creates the PSR and displays it with the Cover Page in the edit mode.
If you do not assign a workflow to the PSR, it displays the Unassigned status.

To assign a workflow to the PSR:

1. Open a PSR and click the Edit button.

2. Select a workflow from the Workflow list. For details, see Workflow tab of a PSR.
3. Click Save.

The status of the saved PSR appears on the right corner of the page. For example, the status
assigned can be - Pending, Submitted, Review, or Released.

Creating a PSR from an Item

You can create PSRs from an Item provided you hold necessary privileges.

To create a PSR from an Item in Java Client:
1. Open an ltem from which you want to create a PSR.
2. Select Create New Product Service Requests from the Actions menu.
3. Inthe New dialog:
a. Choose the desired subclass (NCR or Problem Report) from the Type list.
b. In the PSR Number field, accept the default number, enter a number, or click the Autonumber
A button to generate a new number.
c. Choose a Quality Analyst from the list.
d. Click OK.
Agile Java Client creates the PSR and displays it with the Cover Page tab on top in the edit mode.
4. Enter values in relevant fields on the Cover Page tab.
5. Click Save to save the changes.
The Item appears on the Affected Items tab of the new PSR.

To create a PSR from an Item in Web Client:
1. Open the ltem from which you want to create a PSR.

2. On the ltem page, choose Actions > Create New > Product Service Request. The Create New page
appears.

3. Choose the desired subclass, (NCR or Problem Report) from the Type list.

4. In the PSR Number field, accept the default number, enter a number, or click the Autonumber

123 button to generate a new number.

5. The PSR opens in the edit mode. Click Save to save the changes.
6. The PSR displays the Cover Page. The Item appears on the Affected Items table of the PSR.

Agile Web Client creates a PSR and displays it with the Cover Page tab on top. The Item appears on
the Affected Items tab of the new PSR.
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Creating a PSR to Aggregate multiple PSRs

Consider the fact that you are a Quality Analyst in a firm. You notice several incoming shipments
from suppliers that do not conform to the material specifications. You track down these incidents
and create a single PSR to aggregate all the supplier's incidents.

The single PSR you create is the Parent PSR. All the added PSRs on the Related PSR tab are child
PSRs.

Note  Depending on enabling/disabling the "PSR contains ltems and Related PSRs" SmartRule
setting, you can enable/disable the Affected Items tab after you add Related PSRs.

To create a PSR to aggregate multiple PSRs in Java Client:

1. Open a PSR you want to use as the basis for a new PSR or choose File > Save As or right click
and choose Save As to. See, Creating PSR using Save As on page 20.

2. The PSR opens with the Cover Page in the edit mode. On the Affected Items tab, do not add any
items. On the Related PSR tab, add related PSRs.

3. Click Add to add related PSRs.

After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each child
PSR on the Related PSR tab displays the number of the parent PSR.

To create a PSR to aggregate multiple PSRs in Web Client:

1. Open a PSR you want to use as the basis for a new PSR or choose Actions > Save As. The Save
As page appears.

2. The PSR opens with the Cover Page in the edit mode. On the Affected Items tab, do not add any
items. On the Related PSR tab, add related PSRs.

3. Click Add to add related PSRs. You can also use the combination Ctrl + | keys to launch the
search field.

a. Enter avalue and click the Search to add 5 button to launch a search palette.

b. Click the Create to add pd button to create new PSRs.

After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each PSR on
the Related PSR tab displays the number of the parent PSR. On the Cover Page of the child PSRs, the
Parent PSR number appears in Aggregate PSR Number field, automatically.

Field Completes Indicates

PSR Event Manually Status of the Parent PSR that triggers an automated workflow
event.

Select an available status from the list. You can specify the
status when the PSR has a workflow assigned. When this event
occurs, it means that this PSR has reached the specified status.

Note: Only if you assign a workflow to both objects (parent and
child) on the Cover Page, can you specify the PSR Event status.

PSR Result | Manually The status to which you promote the related PSRs to, when it
reaches the Event status.

When the Parent PSR reaches the specified status in the PSR
event field, the status of the Related PSR moves to the specified
result in this field.
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Note: Only if you assign a workflow to both objects (parent and
child) on the Cover Page, can you specify the PSR Event status.

Creating a PSR using Save As

The Save As feature provides an easy method to create a PSR similar to the existing PSR. The
Save As feature copies data from a field in the existing PSR to the same field of the new PSR. If a
field or a list value in the existing PSR is not available in the new PSR, then the system does not
copy the field or data to the new PSR.

To create a PSR using Save As in Java Client:

1.
2.

3.
4.

Open a PSR you want to use as the basis for a new PSR.

Choose File >Save As or right -click and select Save As. The Save As dialog appears.

a. Select the required sub-class (NCR or Problem Report) from the Type list.

b. In the PSR Number field, accept the default number, enter a number, or click the Autonumber
2 button to generate a new number.

c. Click OK.

Agile Java Client creates a PSR and displays it with the Cover Page in the edit mode.

Enter values in relevant fields on the Cover Page tab.

Click Save to save the changes.

To create a PSR using Save As in Web Client:

WP

~

Open a PSR you want to use as the basis for a new PSR.
Choose Actions >Save As. The Save As dialog appears.
Select the required sub-class (NCR or Problem Report) from the Type list.

In the PSR Number field, accept the default number, enter a number, or click the Autonumber

123 button to generate a new number.

If the original PSR contains Attachments, then a frame displays the following options:

* Reference existing files — creates a new reference to the existing file folder on the new
PSR's Attachments tab.

* Create new copies of files — creates a new copy of the attachment, and places it in a
newly created file folder.

* Do notinclude files — creates a new PSR without any attachments.
Click Save. The new PSR opens displaying the Cover Page in the edit mode.
Enter values in relevant fields on the Cover Page tab.

Click Save to save the changes.

Caution In general, do not use the Save As feature to create an object in a different class or

subclass of the original. The different classes or subclasses may not have the same
tabs or defined fields, and access to data in the newly created object may be lost.
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Fields copied from old object Pre-populated fields
Category, PSR Type, Problem Description, Severity, Product | Originator
Line(s)
Page two and Page Three flex fields Date Originated
Copies all the item information from the Affected Item tab. Status field is set to Unassigned by default.

Copies all attachments from the Attachments tab

History tab reflects the source and target objects

The new PSR copies fields in the optional Page Two and Page Three sections, only if the Agile PLM
Administrator has set appropriate preferences. Since Page Three data applies to a specific subclass
only, if you use Save As to create a new object of a different subclass, the Page Three data is NOT
copied to the new object. For more information about the behavior of Page Two and Page Three fields
in an Agile PLM system, see the Agile PLM Administrator guide.

The PSRs you create remain in the system until you delete them. Deleting PSRs does not remove
them from the Agile database. To delete PSRs permanently, you need to hard-delete them. For
details on deleting PSRs and QCRs, see Deleting Agile Objects on page 69.

Searching for PSRs or QCRs

Agile PLM helps you locate objects by Quick Search, Custom Search, and Advanced Search.
= The Execute a Quick Search button helps you locate objects in the fastest possible way.

= The Custom Search (Ctrl+ Shift +Q) button helps you locate objects by customizing the search
criteria. Search Results display objects matching criteria.

o The Advanced Search button helps you locate specific objects by providing multiple search
criteria.

To run a quick search:

1. Select an object and enter a wildcard (*).

2. Click the Execute a Quick Search button.
The Search results return a list of objects.

Note  Select the Convert to Advanced Search option, if required.

For details, see the 'Searches' chapter in the Getting Started with Agile PLM guide.

Cover Page tab of a PSR

The following table lists and describes the fields on the Cover Page tab of a PSR and provides
information on working with the tabs for Product Service Requests.

Fields Completed Indicates
PSR Automatically, when you create it. The number assigned to the PSR when you
Number Note: In the Admin setting if create it.
'Autogenerate’ is set to 'Yes' then For a Problem Report, the number is pre-fixed
the number will be generated with PR.
automatically, otherwise you have | For a Non-Conformance Report, it is pre-fixed
to enter PSR number. with a NCR.

v9.3.0.2 21



Product Quality Management User Guide

PSR Type Automatically, when you create it. The Type (subclass) selected when you create

the PSR.

Category Manually The list of categories defined by the Agile PLM

Administrator. Examples: Customer Complaint,
Audit - External,
Preventive Action

Description | Usually manually, can contain a Maximum number of bytes is set by the Agile PLM
default. Administrator; up to 4000 bytes, including spaces

and carriage returns (which count as two bytes).

Customer Manually The list of customers associated with this PSR.

Supplier Manually List of suppliers who initiated the incident or are

the cause of the incident.
Severity Manually The list of severities defined by the Agile PLM
Administrator.

Disposition | Manually The list of dispositions defined by the Agile PLM
Administrator.
The Disposition field displays a code that
represents the way in which a PSR is being
resolved.
Examples of dispositions are Replace Component
and Rework to Spec.

Expected Manually Date when the PSR will be resolved.

Resolution

Date

Quality May be provided automatically by The default Quality Analyst.

Analyst the workflow; otherwise selected If you define the workflow to notify the default
manually from a list. Departments Quality Analyst, the department or user in this
appear first in the list, followed by field receives notifications about the PSR. If this
individual user names. field is blank, then the notifications are sent to

every quality analyst on the list.

If the workflow is at the Pending status and has a
Quality Analyst defined than that User receives
notification.

If the notification definition in the workflow is
blank, then no notifications are sent.

Workflow If more than one workflow applies The name of the workflow used to move this PSR
to the PSR, the workflow is through the quality tracking process.
selected manually; the workflow
selection can be changed as long
as the PSR is in the Pending
status. Selecting a workflow
switches the PSR to the
Unassigned status.

You cannot move the PSR to the
next status from the Unassigned
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state without assigning a workflow.

Status Automatically, when created The current workflow state of the PSR. If you do
not select a workflow, the status remains
Unassigned.

Originator Automatically, when created. The default creator of the PSR. Also contains a
list of other problem report originators.

Date Usually automatically, when The date you create the PSR.

Originated created.

Date Automatically generated based on The date when the PSR moves to the Submitted

Submitted workflow status. status in the workflow.

Date Automatically generated based on The date when the PSR moves to the Released

Released workflow status. status in the workflow.

Final Automatically generated based on The date when the PSR moves to the Complete

Complete workflow status. status in the workflow.

Date

Aggregate Automatically filled in when you Automatically fills the parent PSR number.

PSR add PSR(s) to the Related PSR

Number tab.

Product Manually The product lines this PSR affects.

Line(s)

Updating the Cover Page of a PSR

After you create a PSR, you can modify it to provide additional information you did not include when
you created it or edit any information that has changed since its creation. You can modify the fields
on the Cover page several times. Some of the fields, like the PSR Type, on the Cover Page are
populated, automatically.

To edit the Cover Page of a PSR in Java client:

1. Open aPSR. The PSR number and the PSR type fields are pre-populated.

2. Select a value from the list in the Category field.

3. Enter text in the Description field.

4. Click the link to search for Customers.

5. A Select Objects dialog appears. Enter * and click the Search button.

6. From the Search results list, select an object and move it to the Selected Objects column using
the arrow.

7. Click OK.

Alternatively,

o T

Click the Saved Searches tab and search in the available folders.

Click the shortcuts tab and search in Recently Visited folder and the Bookmark folder.
Click the Advanced Search link.

In the Advanced Search dialog, select the Create New or Use a Saved Search option.
Choose from lists or enter text as required.

Click Run to run the search, Click Save to save the changes, click More for additional criteria
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8.
9.

10.
11.

and click Close to close the dialog.
d. Click OKto save the changes or Cancel to return to the Cover Page.
Choose Severity of the PSR from the list.
Choose a Disposition from the list.

Use the calendar and select an Expected Resolution Date.
Click Save to save the changes.

The Cover Page displays modified values.
To edit the Cover Page of a PSR in Web Client:

1. Open a PSR and click the Edit button to modify it.
2.  The PSR number and PSR Type number fields are automatically populated.
3. Select a value from the list in the Category field.
4. Enter text in the Description field.
5. To search for Customers and Suppliers, you can either:
® Click the 2 button below the Customer/Supplier field to launch a search palette and
search for existing Customers or Suppliers.
. # .
® Click the il button to create new Customers or Suppliers.
The Search palette filters, searches, or browses for data from the database.
To search for existing customers or Suppliers:
® Click the 2 button below the Customer/Supplier field to launch a search palette to
search for existing Customers or Suppliers. You can also use the combination Ctrl + L keys
to launch the search field.
*  Enter a known value or type * and click the Execute a Quick Search . "* | button.
® Select a Customer or Supplier from the list that appears. To move the Customer or Supplier to
the Cover Page field, either:
= Drag and drop it.
=  Double-click the object.
=  Press Enter.
a. Click the Close X button to close the palette.
To create new customers:
. # .
b. Click the il button to create new Customers or Suppliers.
c. A Create New dialog appears. In the Type field, select a Customer from the list.
d. In the Number field, enter a number or click the Autonumber 123 button.
e. Enter Customer Name.
f.  Click Save.
6. Choose Severity of the PSR from the list.
7. Choose a Disposition from the list.
8. Click the calendar to select a resolution date. You can also use the combination Ctrl + L
keys to launch the calendar.
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9. Choose a Workflow from the list. Updates of the workflow status are automatic as the PSR
moves to the next status.

10. The Originator and Quality Analyst fields are pre-defined.

11. Click the = palette and choose one or more Product Lines that this PSR affects. You can also
use the combination Ctrl + L keys.

12. Click Save to save changes.

The Cover Page displays modified values.
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Affected Items tab of a PSR

The Affected Items tab of a PSR lists items affected by the current PSR. A single PSR can affect
multiple items (like Parts, Documents). When you add PSRs to the Relationships tab, a PSR Items
table also appears.

Note  You can add Affected ltems only if the PSR is not in the Released status of the workflow.

You can add additional items (like parts, documents, assemblies) that need resolution to the
Affected Items tab. The same applies to QCRs also. You can modify the newly created PSR with
information that has changed since its creation.

A few fields on the Affected Items tab of an NCR are different from that of a PR. The table below lists
additional fields in an NCR. These fields provide additional information about deviations of a product.

The Affected Items table lists and describes the following fields by default.

Field Completed Indicates
Item Number Automatically, when created. Number of the Affected Item.
Item Description Automatically, when created. Description of the item.
Rev Found Manually The revision of the affected Item in which you find

the problem of the Affected Item. For example, if
the item has undergone five revisions, and you
identify the defect in revision B, then Rev found
displays B.

In Web Client, when you select an item to add, all
the revisions of the item appear in the drop-down
list with the latest released revision shown by
default.

Note: You can add multiple copies of an item at
the same revision to the Affected Items tab.

Affected Site Automatically, when created. The site at which the affected items are having
problems.
Failure Mode Manually Displays the reason a product failed or did not

meet customer requirements. Select the failure
mode from a list defined by the Agile Administrator.
You can define a list of failure modes for each
subclass of an item.

For example, a failure mode for a battery might be

No Charge, and the failure mode of a power strip
might be Blown Fuse.

Quantity affected Manually The number of Items affected by the quality
incident.
Rev Fixed Automatically. When you fix The revision of the Item in which the problem is
the problem in the revision. fixed. You can update this field manually or it is
You can also change it populated automatically when you release the
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manually.

ECO.

Note  The Item Number field indicates the ¥ Ascending or ¥ Descending order of the table,

depending on the sort order you choose in the Personalize menu.

Note  The Personalize menu enables you to create and customize Views. Use the Personalize

menu to create and save several views by defining filter conditions, and sort orders. You
can later choose the required view from the list of available views.

Attributes of the Affected Items tab of an NCR

The attributes and operations of NCRs are similar to those of the Problem Reports except for a few

additional fields on the Affected Items tab. These fields provide additional information about
deviations in one or more products.

The table below details the fields of a process in which the quality assurance team examines
incoming materials from a supplier.

Material Date

Field Completed Indicates

Conformance Manually Information about what the materials should be, according to

Specification engineering specifications.

Serial/Lot Manually Serial number or Lot number of the items of the batch that was

Number defective (this is similar to the unique identifier for the batch of
goods).

Total Quantity Manually Total Quantity suspected of problems.

Suspect For example, you receive a lot of 500 units, inspect 20 units and find
that 5 are defective:
500 total suspect
20 checked
5 affected

Quantity Manually The number of inspected items.

Checked

Quantity Manually The actual number of items affected with problems.

Affected

Containment Manually Containment actions taken to dispose material.

Actions

RMA Number Manually Return Merchandise Authorization. This is the number from the
supplier that authorizes you to send the defective materials back to
the source; it is usually a slip of paper.

Conforming Manually The date when the supplier expects to be able to send materials that

does conform to specifications.
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Adding Items to the Affected Items tab of a PSR

You can add Items to a PSR using the Add button on the Affected Items table. Search for existing
Items or create new Items. Items include Parts, BOMs.

To add Items to the Affected items tab in Java Client:

1. Open the PSR and click the Affected ltems tab.

2. Click the Add .j drop-down and choose the Create B button to create new items, the

Search h button to search for one or more existing items, and Type-in-known numbers ﬁ to
search for known items.

To create Items:

1. Select atype from the Type list.

2. If appropriate, enter an ltem number and a description.

3. Click OK.
The Item appears on the Affected Items table.

To search for existing Items:
1. Select a search method from the Add Affected ltems dialog box.

2. To perform a simple search, enter the value to search for and click Search. You can also define
an Advanced Search, run a Saved Search, select a Bookmarked item, or select from the Recently
Visited folder.

3. Select the items from the search results. Use the right arrow or double-click the selected item
to move it to the Select Related Items column.

4. Ensure to select the Edit rows after adding check box, to select different revisions of items or edit
other fields.

5. Click OK.
The item in the Selected Affected Items list appears on the Affected Items table.

To Type in Known Numbers:
1. Enter one or more numbers on separate rows, and click Add.
2. The ltem appears on the Affected Items table.

Note If you click the Add button once without selecting an option from the list, the Type-in
Known Numbers dialog appears.

To add Iltems to the Affected Items tab of a PSR in Web Client:
1. Open the PSR and click the Affected Items tab.
2. Click Add in the Affected Items tab.

=  Click the Search to add 2 button to launch the palette and search for existing items.

=  Click the Create to add | button to create new ltems.

=  Select an Item from the Recently Visited folder, drag and drop it in the Affected ltems
table.

=  Copy an Item existing on one PSR and paste it in the Affected Item's table of another
PSR.
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To search for existing items:

1.

Click the Search to add S button to launch the search palette. You can also use the
combination keys Ctrl + 1 to launch the search field.

Enter the value or * to search for and click the Execute a Quick Search d button.

Select an Item from the list that appears. To move it to the Affected ltems table, you can either:
* Drag and drop it.

* Double-click the object.

®* Press Enter.

Click the Close x button to close the palette.
The Item appears on the Affected ltems table.

To create items:

»

#*
Click the Createtoadd = button.
A Create New dialog appears. In the Type field, select an ltem from the list.

a8 button.

In the Number field, enter a number or click the Autonumber
Enter details in the Description field.
Click Add to add the item to the table or click Cancel to return to the Affected Items table.

The Item appears on the Affected ltems table.

To copy and paste objects:

1.

w

Select an Item from the Affected Item's table of a PSR. (The object can be from either the Related
PSR tab, Relationships tab, or the Attachments tab of a PSR or from another object).

Click the More button and select Copy.

Navigate to the Affected Items tab of another PSR.

Click the More button and select Paste.

The Item appears on the Affected Items table.

Note  An Agile PLM SmartRule named Many Items per PSRs determines whether you can
add multiple items to the Affected Items tab of a PSR. If Many Items per PSR is set

to Allow, you can add more than one Item to the PSR. Otherwise, you can add only
one Item (one row) to the PSR.

Removing an Iltem from the Affected Items tab

To remove an Item from the Affected Items tab in Java Client:

1.
2.

3.
4.

Open a PSR and click the Affected Items tab.
Select the row of the Item you want to remove.

Click the Remove & button.
Click OK in the message prompt box to confirm removal of the Item.

To remove an Item from the Affected Items tab in the Web Client:

1.
2.

Open a PSR and click the Affected Items tab.
Select the row of the Item you want to remove.
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3. Click Remove.

A message bar displays the number of rows removed from the table.

Editing Items on the Affected Items tab

You can edit items on the Affected ltems tab several times if necessary, as long as they are not in the
Released state. You can edit the fields to include additional information or modify existing
information.
To edit the Items on the Affected Items tab in the Java Client:
1. Open a PSR and click the Affected Items tab.

Select the item row you want to edit.

2
3. Click the Edit Affected Items e button. The Edit Affected ltems dialog appears.

4. Double-click the cell of the row, to edit the required fields.

5. Modify text or use the lists to select values.

Alternately, double-click the cell, edit the content and press Enter

When you finish editing, click OK.

For more details on the fields see, the Affected Items tab of a PSR on page 26.

o

Note If you manually update the Rev Fixed field, then you automatically populate the Latest
Change field with the ECO related to that revision change. The Rev Fixed drop-down list
contains all revisions for the item.

For example, you can update, manually the Rev Fixed field in the following cases:

®*  You submit a quality incident, and you already release or implement a known fix; then you
simply update the Rev Fixed field to account for the fact that this problem was already
addressed and corrected in that particular revision.

* Update a PSR that does not have a parent and that is not associated with a change or QCR.

To edit the Items on the Affected Items tab in the Web Client:
1. Open aPSR, and click the Affected Items tab.
2. Select the row you want to edit.

3. To edit the required fields, double-click the cell. Alternatively, navigate to the cell and press
Enter.

4. Enter text or use the lists to select values.
5. Click Save to save the changes.

Note If you manually update the Rev Fixed field, then you automatically populate the Latest
Change field with the ECO related to that revision change. The Rev Fixed drop-down list
contains all revisions for the item.

Related PSR tab

The Related PSR tab contains a list of PSRs that aggregate into a single Parent PSR. Edit information
and aggregate related PSRs into the Parent PSR.

For example, if multiple customers reported similar problems, each problem reported creates a
Problem Report. The Quality team realizes they are related and hence can be resolved with a single
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solution. To resolve the problem, the Quality team creates a single PSR (Parent PSR) and adds

(Aggregates) the related PSRs to the Parent PSR.

The Related PSR tab lists and describes the following columns by default:

Field

Completes

Indicates

PSR Criteria Met
(Image)

Automatically, when
you meet the PSR
Event criteria.

Indicates when the PSR event occurred (that is, the parent
PSR has reached the status selected for the PSR event).

Once the parent PSR attains the status specified in the
PSR Event field, then the related PSR status automatically
moves to the status specified in the PSR Result field and
completes the criteria specified.

Event

Manually

The status of the parent PSR that triggers an automated
workflow event.

Select an available status from the list. You can specify the

status only when the PSR has a workflow assigned. When

this event occurs, it means that the PSR has reached the
specified status.

The default value of the PSR Event is set to the Closed
status. If you have Quality Analyst privileges, you can set
the default value to another status in Java Client. For
details, see the Relationships tab.

Note: You can specify the PSR Event status only when
both objects (parent and child) are assigned a workflow on
the Cover Page tab.

Result

Manually

The status to which the related PSRs are promoted when
the event status is reached. Select an available status from
the list. You can specify the status only when the PSR has

a workflow assigned.

When the parent PSR reaches the status in the PSR Event
field, then the status of the related PSR is automatically
moved to the specified result status in this field.

The default value of the PSR Result is set to the Closed
status. If you have Quality Analyst privileges, you can set
the default value to another status in Java Client. For
details, see Relationships tab.

Note: You can specify the PSR Result status only when
both objects (parent and child) are assigned a workflow on
the Cover Page tab.

PSR Type

Automatically

The type of the PSR

PSR Number

Manually; when you
enter PSR number

The related PSR number.

PSR Category

Automatically

The quality incident category of the related PSR.

PSR Customer

Automatically

The customers associated with the related PSR.

PSR Supplier

Automatically

The suppliers associated with the related PSR.
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PSR Severity Automatically The severity of the related PSR. The Agile PLM
administrator defines the severities.
PSR Disposition Automatically The way the PSR was resolved.
PSR Expected Automatically The date you expect the resolution for the related PSR.
Resolution Date
PSR Quality Automatically The quality analyst assigned to the related PSR.
Analyst If you define the workflow to notify the default quality
analyst, the department user in this field receives
notifications about the PSR
PSR Workflow Automatically The name of the workflow used to move this PSR through
the quality tracking process.
PSR Status Automatically The workflow status of the related PSR. If you do not select
a workflow, this field is Unassigned.
PSR Originator Automatically, when The default creator of the PSR.
created
PSR Date Usually The date when you create the related PSR.
Originated automatically, when
created
PSR Date Usually The date when you submit the related PSR.
Submitted automatically, when
created
PSR Date Usually The date when you release the related PSR.
Released automatically, when
created
PSR Final Usually The date when you complete the related PSR
Complete automatically, when
Date created
Aggregate PSR Automatically filled Field filled in automatically with the parent PSR number.
Number in when PSRs are
added to the
Related PSR tab.
Note The Event field indicates the ¥ Ascending or * Descending order of the table,

depending on the sort order you choose in the Personalize menu.

Note  The Personalize menu enables you to create and customize Views. Use the personalize

menu to create and save several views by defining filter conditions, and sort orders. You
can later choose the required view from the list of available views.

Adding Related PSRs to the Parent PSR

To add Related PSRs to the Parent PSR in Java Client:
1. Open a PSR and click the Related PSR tab.

32 Agile Product Lifecycle Management



Chapter 2: Working with Product Service Requests

2.

Click j and choose one of the following options.
®*  The Create B button allows you to create objects.

® The Search h button allows you to search for existing objects.

To create objects:

1.

2
3.
4

Click the Create button. A New dialog appears.

Select a type from the Type list.

Enter an object number or click the Autonumber A to generate a new number.
Click OK.

The object appears on the Related PSRs table.

To search for one or more existing objects:

1.
2.

In the Add Related Objects dialog box, select a search method.

To perform a simple search, enter a value and click Search. You can also define an Advanced
Search, run a Saved Search, select a Bookmarked object, or select from the Recently Visited folder
(Shortcut).

Select the objects from the search results. Use the right arrow or double-click to move it to the
Select Related Objects column.

To select different revisions of objects or edit other fields, ensure to check the Edit rows after
adding check box.

Click OK.
The object appears on the Related PSRs table.

Note If you click the Add icon without selecting the list, you see the Add Related PSR
(Search) dialog box.

To add Related PSRs to the Parent PSR in Web Client:

1.
2.

Open a PSR and click the Related PSR tab.
In the Related PSR table, click Add.

®  Click the Search to Add Q button to launch the search palette to search for existing
PSRs.
*
e Click the Createto Add J button to create new PSRs to add to the Related PSR tab.
* Select a PSR from the Recently Visited folder, drag and drop it in the Related PSRs table.
®* Copy a PSR existing on one PSR and paste it in the Related PSR table of another PSR.

To search for existing objects:

1.

Click the Search to Add Q button to launch a palette to search for existing PSRs. Use the
combination Ctrl + | keys to launch the search field.

Enter the value or type * and click the Execute a Quick Search "* | button.

Select a PSR from the list that appears. To move it to the Related PSR table and either:
* Drag and drop it.
* Double-click the object.

v9.3.0.2 33



Product Quality Management User Guide

®*  Press Enter.

4. Click the Close X button to close the palette.
The object appears on the Related PSR table.

To create new objects:

. #
Click the Create to Add e button to create new PSRs.

1.

2. A Create New dialog appears. In the Type field, select an object from the list.

3. In the Number field, enter a number or click the Autonumber 125 button.

4. Enter details in the Description field.

5. Click Add to add the object to the table or click Cancel to return to the Related PSR table.

The object appears on the Related PSR table.

Editing Items on the Related PSRs tab

You can edit the information in the fields of the Related PSRs tab to include additional information or
modify existing values.

To edit Related PSRs in Java Client:

Open a PSR and click the Related PSR tab.

On the Related PSR table, select the row you want to edit.

Click the Edit % button to edit the row.

Double-click the cell you want to edit.

Use the list to select values and edit required fields.
Click OK.

To edit Related PSRs in Web Client:

1. Open a PSR and click the Related PSR tab.

2. On the Related PSR table, select the row you want to edit.
3. Double-click the cell you want to edit

S e o

Note A cell that does not open, displays a message that the field is not editable.

4. Use the list to select values and edit required fields.
5. Click Save to save changes.

Note  The PSR Event drop-down list shows the available statuses of the Parent PSR. You can
select the statuses of the parent and the related PSR, such that when the Parent PSR
reaches the status in the PSR Event field, the related PSR moves to the status in the PSR
Result field.

Note  For example, if you set the PSR Event field to Closed and the PSR Result field to Closed,
once the Parent PSR reaches the Closed status, the related (child) PSR moves
automatically to the Closed status.

Removing Related PSRs

To remove Related PSRs in Java Client:
1. Open a PSR and click the Related PSR tab.
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2. Select the PSR you want to remove.
3. Click the Remove [é button.
A dialog prompts you to remove the related PSR after confirmation.

To remove Related PSRs in Web Client:
1. Open a PSR and click the Related PSR tab.
2. Select the PSR you want to remove.
3. Click Remove.
A message bar displays the number of rows removed from the table.

Note  The number of the Parent PSR does not appear in the Aggregate PSR Number field on the
Cover Page of the PSR.

Relationships tab

The Relationships tab allows you to create relationships between the current PSR or a QCR and other
routable and lifecycle objects. The relationship is visible on Relationships tab of both the objects. You
can specify a rule between the objects, which is optional.

Relationships tab of Agile objects have the option to specify a rule between the objects. When you
position the cursor on the PSRIQCR, it displays a Quick View info link. A click on the Quick View dialog
provides substantive information without having to navigate to the object. A message bar displays
the Add rule link and (if you specify a rule) displays it in the Web Client. Once you specify a rule, the
Edit Rule and Remove Rule links appear on the message bar. Specific objects display tables with
related views and actions that you can perform.

Relationships - Table

The Relationships table lists all the Agile objects. In the Relationships table:

Exists - Indicates that the functionality exists for that class and its subclasses.

In the Relationship with a Rule column:

Yes - Indicates you can add the functionality to its class and subclasses.

No — Indicates that it does not support the functionality.

In the Event/Result column:

Workflow - indicates the event /result for a class object, based on the workflow state of that object.

Lifecycle - indicates the event/result for a class object, based on Lifecycle state of that object.
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Agile Agile Event/ Relationship | References- | Lifecycle
Base Classes Result with Relationship under
Class a Rule with no rule Change
Control
Changes Change Workflow Exists Exists NA
Orders
Change Workflow Exists Exists NA
Requests
Deviations Workflow Exists Exists NA
Manufacturers | Workflow Exists Exists NA
Orders
Price Change | Workflow Exists Exists NA
Orders
Site Change Workflow Exists Exists NA
Orders
Stop Ship Workflow Exists Exists NA
Customers Customers Lifecycle Yes Exists No
Declarations Homogeneous | Workflow Exists Exists NA
Material
Declaration
IPC 1752-1 Workflow Exists Exists NA
Declarations
IPC 1752-2 Workflow Exists Exists NA
Declarations
JGP SSI Workflow Exists Exists NA
Declarations
Part Workflow Exists Exists NA
Declarations
Substance Workflow Exists Exists NA
Declarations
Supplier Workflow Exists Exists NA
Declaration of
Conformance
File Folders File Folder Lifecycle Yes Exists No
ltems Documents Lifecycle Yes Yes NA
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Parts Lifecycle Yes Yes NA
Manufacturer | Manufacturer | Lifecycle Yes Yes NA
Parts Parts
Manufacturer | Manufacturer | Lifecycle Yes Yes No
Packages Packages Workflow Yes Yes
Part Groups Part Groups Lifecycle Yes Yes No
Prices Published Lifecycle Yes Yes Yes
Process
Quote Lifecycle Yes Exists Yes
Histories
PSRs Non Workflow Exists Exists NA
Conformance
Reports
Problem Workflow Exists Exists NA
Reports
Programs Activities Workflow Exists Exists NA
Gate Workflow Exists Exists NA
QCRs Audit Workflow Exists Exists NA
CAPA Workflow Exists Exists NA
Requests for | Requests for Lifecycle Yes Yes No
Quotes Quotes
RFQ RFQ Lifecycle Yes Yes No
Response Response
Sites Sites Lifecycle Yes Yes No
Sourcing Sourcing Lifecycle Yes Yes No
Projects Projects
Specifications | Specifications | Lifecycle Yes Yes No
Substances Materials Lifecycle Yes Yes No
Sub Parts Lifecycle Yes Yes No
Substances Lifecycle Yes Yes No
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Suppliers Suppliers Lifecycle Yes Yes No
Transfer Automated Workflow Yes Yes NA
orders Transfer
Orders
Content Workflow Yes Yes NA
Transfer
Orders
User Groups User Groups None No Yes NA
Users Users Status No Yes NA
Attribute
Action Items Action Items Status No No NA
Attribute
Discussions Discussions None No Yes NA
Reports Custom None No No NA
Reports
External None No No NA
Reports
Standard None No No NA
Reports

Relationships in PQM

This is some additional information about relationships as they are used in the PQM solution:

Important When relationships are created between PQM objects, a blank rule is created for the

relationship. You must edit the blank rule to define how you want the PQM objects to
affect each other.

When a QCR affects the PSR, that is, when a QCR and PSR are related and the relationship
rule follows the format:

When <QCR source object> is <event>, set <PSR target object> to <result>

all items from the PSR Affected Items tab are displayed on the PSR Items table of the QCR. If
the PSR was used to aggregate multiple PSRs, then the related PSRs’ affected items are
displayed.
When this QCR is affected by a PSR, that is, when the QCR and the PSR are related and the
rule follows the format:

When <PSR source object> is <event>, set <QCR target object> to <result>.

all items from the PSR Affected Items tab and the related PSR’s affected items are not displayed
on the PSR Items table of the QCR.
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Attributes of a Relationship

When you add an object to a project as a deliverable, you add the project on the relationship tab of
that object as well. You can define a relationship rule between these two objects and view the rule
from both objects.

= When you add an object as a relationship to the second object, it creates a reverse relationship
and displays the second object under the Relationships tab of the first object.

o There are no default relationship rules between two objects.
= When you add a relationship to an object that has a revision:

* The name field of parts or documents shows the object name or number only if the rule is
pending. Click the object name or number. In the editable fields, enter text or use the lists.
The revision displays the latest revision.

®* The object revision displays in the name field when the rule is met, (i.e. the lifecycle of the
event has occurred).

*  For example, if the triggering event is when the lifecycle moves to Production, then you
see the first revision of the production phase here.

®* The name field value is hyper-linked and links to the cover page for revision.

* |n Java Client, to add, edit or remove a rule, click the Add Rule, Edit Rule or Remove Rule
button respectively.

* In Web Client, a message bar displays the rule. You can also use the edit and remove rule
links to edit and remove the rule.

* Attachments related to folders display folder version when the set criteria is met.
For details, see the 'Relationships' chapter in the Getting Started with Agile PLM guide.

Relationships tab Tools

The Relationships tab has the following buttons:

o Add: Allows you to add objects.

= Remove: Allows you to remove objects.

o Edit Rule: Allows you to add a rule or edit the rule.

= More: Contains more actions that you can perform. (copy, paste, fill-down, fill-up)

The Relationships tab page includes the Views and Personalize buttons. The Personalize menu
enables you to create and customize Views. Use the personalize menu to create and save several
views by defining filter conditions, and sort orders. You can later choose the required view from the
list of available views.

See also: Relationships Table on page 39. For details on Views, see the chapter 'Navigating in the
Agile Web Client' in the Getting Started with Agile PLM guide.
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Relationships Table

The Relationships table lists the following columns by default;

Field Completed Indicates
Criteria Met | Automatically. When you meet Indicates when the added object attains the
(image) relationship rule of the objects specified status. Once you meet the criteria, you see
added. the symbol 7 in the Web Client and “' in the
Java Client.
Type Automatically The type (image) of the object you add.
(Image)
Name Automatically The name of the object
Description | Automatically The description of the object you add with the
number. For example, (PR00054).
Current Automatically when you add The current status of the related object.
Status the object.
Rule Automatically when you add Displays the rule specified.
the rule Note: You can specify Rule only if you assign a
workflow to the PSR.
Type Automatically The type of the added object. (For example,
Problem Report)

Note  The Name field indicates the ¥ Ascending or ¥ Descending order of the table,
depending on the sort order you choose in the Personalize menu.

Note  The Personalize menu enables you to create customized Views. Use the personalize
menu to create and save several views by defining filter conditions, and sort orders. You
can choose the required view from the list of available views.

Adding Objects to the Relationship tab of a PSR

You can add any of the Agile objects to a Relationships table. The Administrator needs to set
appropriate privileges to define Relationships between Agile objects.

To add objects to the Relationships table in Java Client:
1. Open a PSR and click the Relationships tab.
2. Click the Add .El button in the Relationships table.

® The Create i button allows you to create new objects.

® The Search h button allows you to search for one or more existing objects.

To create objects:
1. Click the Create button. A New dialog appears.
2. Select a sub-class from the Type list.

3. Enter a number or click the Autonumber button.
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4. Click OK.
The object appears on the Relationships tab.

To search for existing objects:
1. Inthe Add Relationship dialog box, select a search method.

2. To perform a simple search, enter value to search for and click Search. You can also define an
Advanced Search, run a Saved Search, select a Bookmarked object, or select from the Recently
Visited folder (Shortcuts).

3. Select the items from the Search Results. These can be PSRs, QCRs, or Changes. Use the
right arrow or double-click the selected object to move it to the Selected Related Objects column.

4. To select different revisions of items or edit other fields, ensure to select the Edit rows after
adding check box.

5. Click OK.
The selected object appears on the Relationships table.

To add a relationship or reference to an object in Web Client:

1. Go to the Relationships tab of the object.

2. Use one of these options to add a row to the Relationships table:
3. Click the Add menu button and choose one of the following options:

®* Choose By Search to open the search palette. Execute a quick search to find the objects
you want. Double-click to add an object. Press Escape to close the palette.

® Choose By Create to create a new object. Select an object type, fill in any required fields,
and then click Add. The newly created object is added to the table.

4. Drag and Drop
® Select an object in the left navigation pane. Drag it onto the table and drop it. You can drag

and drop from your Es* My Bookmarks, {3 Recently Visited list, and the #*NAVIGATOR
drawer.

5. Copy and Paste

* Copy one or more objects from a table: search results table, BOM table, Where Used
table, and so forth. Use More > Copy or Ctrl-C to copy the rows.

*  Open the object to which you want to add a relationship. Click the Relationships tab to
display it. Paste the rows by using More > Paste or Ctrl-V.

You can add Problem Reports or a Non-Conformance Reports to the Relationships tab of any other
Agile objects.

Editing the Relationships table

You can edit the Relationships table to include additional information or modify existing information.

To edit the Relationships table in Java Client:
Open a PSR and click the Relationships tab.
Select the row you want to edit.

Click the Edit Relationship % button.
Modify required fields.
Click OK.

The modified values appear on the table.

ok w DR
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To edit the Relationships table in Web Client:
1. Open a PSR and click the Relationships tab.
2. Double-click the field you want to edit.

3.  Modify required fields.

4. Click Save.

The modified values appear on the table.

Removing Relationships

You can remove an object on the Relationships tab if found to be inappropriate. Removing a
relationship from the Relationships tab of an object also removes it from the Relationships tab of the
object to which it is related.

To remove Relationship in Java Client:

1. Open a PSR and click the Relationships tab.

2. Select the object row you want to remove.

3. Click the Remove Relationship [é button.
The object does not appear on the Relationships table.

To remove Relationship in Web Client:

1. Open a PSR and click the Relationships tab.
2. Select the object row you want to remove.
3. Click the Remove button.

A message bar displays the number of rows that have been removed. The object does not appear
on the Relationships table.

Relationship Rules

The Relationship rule specifies how the workflow you define for an object affects the workflow status
of another object. For example, When PR0048 is Submitted, Set PRO0049 to Review.

= Alifecycle object can only be a source and not a target of a relationship.

A lifecycle object can only be a source and not a target of a relationship. When you add a
relationship from a lifecycle object to a workflow object, the state of the lifecycle affects the
state of the workflow object.

For example, the relationship rule is defined between a Problem Service Request (workflow
object) PR00061 and a (workflow object) Engineering Change Order. The rule says that, When
PRO00061 is Released, Set the Engineering Change Order to Released. Fix the positions of the
“From Object” (PR00061) and the “To Object” (Engineering Change Order) in the rule so that
the rule only affects workflow objects.

When you add a relationship from a workflow object to a lifecycle object, the state of the
lifecycle objects affects the state of the workflow object and not the reverse way.

= When you add a relationship from a workflow object, you can define a relationship rule to another workflow
object in both directions.

For example, in a relationship between two workflow objects — QCR QCR12345 and PSR
PR55768 the When drop-down will list two objects — QCR12345 and PR55768, the Set drop-
down will also have the same two objects. You cannot select the same object in both, When and
Set. When you select an object from When list the Set field will be upgraded with another object.

The relationship should be viewable from both the objects and the rule displayed must be the
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same.

= You cannot define a relationship rule between two lifecycle objects.

You can only define a relationship rule only between a lifecycle object and a workflow object
and not between two lifecycle objects.

Adding Relationship Rules

The Relationships tab has the option to associate a rule between objects. Specific objects display
tables with related views along with the actions that you can perform on the related object.

For example, if you add Items to the Relationships tab, the table displays an Affected Items table with
the Item Number and Item description fields. The number field is a hyper-link.

To access more information about this object, click the Quick View info link. This appears when you
position the cursor on the corresponding object and allows you to view details of the object and
perform some actions without navigating to the actual object.

The message bar in the Quick View dialog displays the Add Rule link, which allows you to specify a
rule. Once you specify a rule, the Edit Rule and the Remove Rule links also appear.
To add a Relationship rule in Java Client:
1. Open a PSR and click the Relationships tab.
Select the PSR row you want to add a rule in.

2
3. Click the Add Rule (4 button.
4. A Relationship Rule dialog opens. Specify a rule.
For example:
When PR0O002 is Review
Set PR123304 to Submitted.
5. Click OK.

The rule appears in the Relationship table of the corresponding object.

To add a Relationship Rule in Web Client:
1. Open a PSR and click the Relationships tab.

2. On the Relationships table, you can either use the Edit Rule button to add a Rule or click the
Quick View info link that appears when you position the cursor on the PSR.

3. Adialog appears. A message bar displays the Add rule link or the rule (if specified).
Click the Add Rule link.
5. The Relationships Rule dialog opens. Specify a rule.
For example,
When Problem Report PR000142 is Review
Set Problem Report PR00144 to Submitted.
6. Click Save.
The rule appears on the message bar.

»

7. Click the Close X button to close the palette.
Alternately, you can use the Edit Rule button to add a rule.

The rule appears in the Relationships table of the corresponding object.

v9.3.0.2 43



Product Quality Management User Guide

Editing Relationship Rules

You can modify the rule of an object on the Relationships table. Use either the Edit Rule button on
the Relationships table or the Edit Rule that appears in the Quick View dialog message bar.

To edit the Relationship rule in the Java Client:

1. Open a PSR and click the Relationships tab.

2. Select a row on the Relationships table you want to edit.

3. Click the Edit Rule (" button.

In the Relationships Rule dialog, modify the rule.
Click OK.

The modified rule displays on the Relationships table.

S

To edit the Relationship rule in the Web Client:
1. Open a PSR and click the Relationships tab.
2. You can either:
Click the Edit Rule button.
* In the Relationships Rule dialog, modify the rule.
® Click Save to save the changes.
Click the Quick View info link that appears when you position the cursor on the PSR.
®  Click the Edit Rule link.
® In the Relationships Rule dialog, modify the rule.
® Click Save to save the changes.

3. Click the Close x button to close the palette.
The modified rule displays on the Relationships table.

Removing Relationship Rules

You can remove the rule associated with the relationship, if not applicable. In the Web Client, once
you specify a rule, the message bar on the Relationship dialog displays the Remove Rule link.

To remove the relationship rule in Java Client:

1. Open a PSR and click the Relationships tab.

2. Select the row on the Relationships table, which contains the rule.

3. Click the Remove Rule ® button. A dialog confirms removal of the rule.
The rule does not appear in the Rule column.

To remove the relationship rule in Web Client:
1. Open a PSR and click the Relationships tab.
2. Click the Quick View info link, which appears when you position the cursor on the PSR.
3. Inthe dialog that opens, click the Remove Rule link.
Alternately, use the Edit Rule button on the Relationships table to remove the rule.

The rule does not appear in the Rule column.
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Filter

Filters narrow down the objects in the Relationships tab of PSRs by the rule they contain. You can
filter relationships with the attributes you configure using the filter option. The Relationships tab of the
Java Client includes the Filter button. In the Web Client, use the Personalize menu to filter
relationships.

In the Java Client, the default View options consist of 4 values:

All Relationships

This filter allows you to filter all the relationship objects in the table.

Complete

This filter allows you to filter all the objects for which the rule criteria are met.
Pending

This filter allows you to filter objects for which the rule criteria are not met.
Rule not specified

This filter allows you to filter objects for which there are no rules specified.

Click the Show Filter ' button. An additional row appears above the Relationships table. You can
filter using the following attributes:

o Criteria Met - Filters relationships where the set criteria are met.
o Name - Filters relationships by names.

o Description - Filters relationships by the description.

o Rule - Filters relationships by rules.

o Type - Filters relationships by the types.

In the Web Client, the Views menu on the upper right helps you create views using the Personalize
menu. The Personalize menu allows you to filter relationships. Define filter criteria based on the
options in the Table Personalization palette.

Additional attributes listed below help filter relationships further.
*  Criteria Met - Filters relationships where the set criteria are met.
* Name - Filters relationships by names.
*  Description - Filters relationships by the description.
®  Current Status - Filters using the current status.
* Rule - Filters relationships by rules.
* Type - Filters relationships by the types.

For details on Views and Personalize menus, see the Getting Started with Agile PLM guide.

Workflow tab of a PSR

An Agile PLM workflow is a sequence of statuses that a routable object goes through in the quality
control process. The Workflow tab displays a flowchart of the workflow you select on the Cover
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page.
The Workflow tab page displays two sections:

1. Summary - lists sign-off information for the current status. This section is visible for review
or release statuses.

2.  Workflow - displays the chart of the current workflow. This section is visible for all changes
to which you assign a workflow.

Workflow statuses are represented by different colors:
®* Green - Previous Performed Status
* Orange - Current status
® Blue - Future status

The Sign-Off History table displays past workflow and sign-off information for the PSR. For example,
you can route a PSR:

¢ internally for preliminary investigation

® to a manager for escalation to identify if it merits a corrective action

* to the support call center/ field service technician who can provide a detailed information
® to the customer for final approval of an implemented fix

* to a supplier for a response to the incident, and so on.

The Personalize menu enables you to create and customize Views. Use the personalize menu to
create and save several views by defining filter conditions, and sort orders. You can later choose
the required view from the list of available views. The Add Reviewers / Remove Reviewers buttons allow
you to add/remove Approvers and Observers.

For details, see the 'Routing Objects with Workflows' chapter in the Getting Started with Agile PLM
guide.

Shown below is a view of the workflow statuses available for a PSR. The workflow of a Problem
Report is similar to the workflow of a Non-Conformance Report.

-—. Submitted  ——p  REView o Relessed ——p  Clozed

Submitting and Routing PSRs

You can create routable objects from classes that represent processes. For example, changes in
the change control process, or a product service request. Route objects to Agile PLM users for
approval via workflows. Use the Next Status button on the Cover Page of the PSR to route objects.
Routing managers oversee the routing and approval process of objects, evaluate and assign
routable objects and receive e-mail notifications. Quality Analysts are the default routing manager
for PSRs.

For details, see the 'Routing Objects with Workflows' chapter in the Getting Started with Agile PLM
guide.
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Attachments tab of a PSR

An Attachment contains supportive data in the form files, documents, drawings, images. You can
reference files and URLs from the Attachments tab of all Agile PLM objects. You can track and
search attachment files and URLSs, and also add files to an automatically created object called a file
folder - an object of reference information from the File Folders class.

The actual attachment files are stored in the Agile File Manager, referred to as the file vault.
Attachments may contain information that describes the object or a process. For example, if a
specification describes a part or subassembly, it might have the following attachment files:

= Drawing files (such as CAD drawings) or scanned image files in viewable formats
o Files such as documents, non-viewable files, compressed (ZIP) files, and so on
Attachments tab actions allow you to add, delete, open, view, print, or get a copy of the attachment

file. You can also check in and check out attachments (although you are actually checking file folder
objects in and out).

Note  The Personalize menu enables you to create and customize Views. Use the personalize
menu to create and save several views by defining filter conditions, and sort orders. You
can later choose the required view from the list of available views.

Also see 'Working with Attachments' chapter in the Getting Started with Agile PLM guide.

Adding Attachment Files to a PSR

To add an Attachment file to a PSR in Java Client:
1. Open a PSR and click the Attachments tab.

Click the Add Files ﬂ button.

In the File Uploader dialog, click the Browse for Files button.
Select and double-click the file you want to add.

Click the Options arrow.

Select the Type of file from the list.

Check the following options as required:

No g MDD

® Unzip all zipped files upon upload.
* Add all files to a single File Folder.
* Edit rows after adding.
8. Click Upload.
At the prompt, delete uploaded files from your local disk.
The file appears on the Attachments table.

To add an Attachment file to a PSR in Web Client:
1. Open a PSR and click the Attachments tab.
2. Select Files / URLs / By Search from the list on the Add button.

3. Choose Add Files. Before the Add Files dialog appears, a File Upload and Download Method dialog
opens.

* Select Use standard browser capabilities / Use Java Upload / Download tool.
* Click OK.
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® Use the Browse button to locate files in the Add Files dialog.

* Afile folder containing the attached files is created. To add selected files in one file folder,
select the Add all files to a single file folder check box, or else a file folder is created for each
file selected.

® Click Add.
The file name and file folder objects appear in the Attachments table.
Choose URLs. The Add URLs dialog appears.

* To add selected URLs in a single file folder, select the Add all URL's to a single file folder
checkbox or else a separate file folder will be created for each URL.

* Click Add.
The URLs and the file folder objects appear in the Attachments table.
Choose By Search. The Add Files dialog appears.

® Inthe Add Files palette, enter "*' wildcard and search for files or URLSs. You can also choose
the latest version of the files.

®* To move the selected file to the Attachments table, you can either:

®* Drag and drop it

* Double-click the file

® Select the file and press Enter

* Enter the URL address. Alternately, you can also copy and paste an URL.

* Atable at the base displays the selected objects and corresponding files attached.

®  Click the Close x button or hit the Esc button to close the palette.
The file / URL and the file folder objects appear in the Attachments table.

Removing Attachment Files from a PSR

To remove Attachment Files from a PSR in Java Client:

1.
2.

3.

Open a PSR and click the Attachments tab.
Select the File / URL you want to remove.

Click the Remove [é button.
The File / URL no longer appears on the Attachments tab.

To remove Attachment Files from a PSR in Web Client:

1. Open a PSR and click the Attachments tab.

2. Select the file or URL you want to remove.

3. Click the Remove button.
The File / URL does not appear on the Attachments table. A message bar displays the number of
rows removed.
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In Product Quality Management, Quality Change Requests (QCR) creates and manages Audits and
Corrective and Preventive Actions. The QCR allows you to aggregate problems into a routable quality
record, perform an analysis of the cause of the failure and closes the problem using standard CAPA
procedures.

This chapter includes the following topics:
o Creating Quality Change Requests on page 49

o Cover Page tab of a QCR on page 52

o Affected Items tab of a QCR on page 55

= Relationships tab of a QCR on page 57

= Workflow tab of a QCR on page 57

o Attachments tab of a QCR on page 59

o Submitting and Routing a QCR on page 59

Creating QCRs

You can create QCR objects the same way you create other Agile PLM objects if you have the
necessary privileges. The Quality Administrator role allows you to perform all the functions related
to QCRs. For more details on Roles and Privileges, see the Getting Started with Agile PLM guide.

You can use the New Object button or the Save As feature to create a QCR.

To create a QCR in Java Client:
Launch the Java Client.

2. Click the New Object % button. The New Object dialog box appears.
3. Inthe Type list, select a value.
4. In the QCR Number field, accept the number that appears, or enter a number, or click the

Autonumber [ button to generate a number.
5. Click OK.
Agile Java Client creates the QCR object and displays the QCR (Audit or CAPA) with the Cover Page
tab in the edit mode.
To create a QCR in Web Client:
1. Launch Agile Web Client.

2. From the main toolbar, click the Create New drop-down button. Select Quality Change Request >
Audit or Corrective and Preventive Actions. The Create New dialog appears.

3. Inthe Type field, select a value from the list.

4. In the QCR Number field, accept the default number, enter a number, or click the Autonumber

123 button to generate a number.

5. Click Save.
Agile Web Client creates the QCR and displays it with the Cover Page tab in the edit mode.
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If you do not assign a workflow to the QCR, the QCR displays the Unassigned status.

To assign a workflow to the QCR:

1. Open a QCR and click the Edit button.

2. Select a workflow from the Workflow list. For details, see Workflow tab of a QCR.
3. Click Save.

The status of the saved QCR appears on the right corner of the page. For example, the assigned
status can be - Prepared, Submitted, Review, or Released.

Note  The system sends an audit reminder to the Originator and Quality Administrator before
the audit date. If you have Modify privileges, you can configure the audit reminder date in
the file.

Creating a QCR using Save As

You can create a QCR using the Save As feature. The Save As feature creates a similar object with
different values, since it copies data from a field in the existing object to the same field in the new
object.

Do not use the Save As feature to create an object in a different class or subclass, since they may
not include the same tabsf/fields, and hence lose data.

Warning If a field or list value in the existing object is not available in the new object, then the
system does not copy that field or list value to the new object.

To create a QCR using Save As in Java Client:
1. Open the QCR you want to use as the basis for the new QCR.

2. Right-click, and choose Save As. Alternatively, choose File and select Save As from the main
toolbar. The Save As dialog box appears.

3. From the Type list, select an Audit or CAPA.

4. In the QCR Number field, accept the number that appears. You can also type a number or click
the AutoNumber button to generate a number.

5. Click OK.

6. Agile Java Client creates the QCR (Audit or CAPA) and displays the QCR with the Cover Page tab
in the edit mode.

7. Modify required fields.
8. Click Save to save the changes.

To create a QCR using Save As in Web Client:

1. Open the QCR you want to use as the basis for the new QCR.

Click the Actions drop-down menu.

Select Save As.

In the Save As dialog that appears, select Audit or CAPA from the Type list.

In the QCR Number field, accept the default number, enter a number, or click the Autonumber
123

a bk wbd

button to generate a number.
. Click Save.
7. The QCR opens displaying the Cover Page in edit mode. Modify required fields.
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8. Click Save to save the changes.
9. The QCR appears displaying the Cover Page.

Note Ifthe Agile PLM Administrator has set the appropriate preferences, the system copies
fields in the optional Page Two and Page Three sections to the new object. For
information about the behavior of Page Two and Page Three fields in your Agile PLM
system, contact your Agile PLM Administrator. Since Page Three data applies only to a
specific subclass, if you use the Save As feature to create a new object of a different
subclass, the system does not copy Page Three data to the new object.

To enable Save As preferences for Page Two and Page Three fields, refer Admin> Server Settings>
Preferences - Save As Page 2 for Different Classes, Save As Page 3 for Different Classes, & Save
As Page 3 for Different Subclasses, in the Java Client.

Creating a QCR from an Item

You can create a QCR from a PSR or an individual ltem. When you create a QCR from an Item to drive
a problem to closure, you add:

o the ltem to the Affected ltems table of the QCR.
@ the QCR to the QCRs table on the Quality tab of the Item.

After you approve the QCR, you can route the Item through the change to ensure you rectify the
defect and change to the new revision of the Iltem.

To create a QCR from an Item in Java Client:

1. Open an existing an Item.

2. Right-click in the object window and choose Create a Quality Change Request from the drop-down
menu.

3. Select the required sub-class Audit or CAPA from the Type list.

4. In the QCR Number field, accept the number that appears, enter a number or click the
Autonumber [ button to generate a number.

5. Click OK.
Agile Java Client creates the QCR and displays it with the Cover Page in the edit mode.

To create a QCR from a PSR or an Item in Web Client:
1. Open an existing an Item. It opens displaying the Cover Page.
2. Click the Actions button on the Cover Page.

3. Choose Create New>Quality Change Request from the drop-down menu. The Create New dialog
appears.

4. Select the required sub-class (Audit or CAPA) from the Type list.
5. In the QCR Number field, accept the number that appears, enter a number or click the

Autonumber *® | button to generate a number.

The Agile Web Client creates the QCR and displays it with the Cover Page in the edit mode.
The QCRs you create remain in the system until you delete them. Deleting QCRs does not remove

them from Agile database. To delete a QCR permanently from the system you need to hard-delete
them. For details on deleting QCRs, see Deleting Agile Objects on page 69.
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Creating a QCR from a PSR

Creating QCRs from PSRs allows you to tag corrective actions on to a Product Service Request.
You can create a QCR directly from a PSR or an individual item. You can create a QCR using the
Actions Menu in Web Client and the More button in Java Client. The QCR allows you to aggregate
incoming problems into a routable quality record, perform root-cause failure analysis, and drive the
problems to closure using standard CAPA (corrective and preventive actions) procedures.

To create a QCR from a PSR in the Java Client:
1. Open an existing PSR.

Click the More [E button.

2.

3. Select the Create Quality Change Request from the drop-down menu.

4. A New dialog appears. Select the required sub-class Type (Audit or CAPA).

5. In the QCR Number field, accept the default number, enter a number, or click the Autonumber 53]

button to generate a number.
6. Click OK.

The QCR opens in the edit mode.

To create a QCR from a PSR in Web Client:
Open an existing PSR.

Click the Actions menu.

Select the Create Quality Change Requests option.

A Create New dialog appears. Select the required sub-class (Audit or a CAPA) from the Type
list.

5. In the QCR Number field, accept the default number, enter a number, or click the Autonumber
123

pPwdhPE

button to generate a number.
6. Click Save.

The QCR (Audit or CAPA) opens in the edit mode.

Cover Page tab of a QCR

The following table lists and describes the fields on the Cover Page tab of a QCR.

Field Completed Indicates

QCR Number Automatically, when created The number you assign to a QCR, when you create it.

QCR Type Automatically, when created The type of subclass you select when you create the
QCR.

Category Manually A list of categories defined by the Agile PLM
Administrator.

Description Usually manually, can contain | Describes the QCR. Maximum number of bytes is set

a default. by the Administrator; can be up to 4000 bytes,

including spaces and carriage returns (which count as
two bytes).

Reason Usually manually; can contain | Reason for creating the QCR. Maximum number of

bytes is set by the Administrator; can be up to 4000
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a default bytes, including spaces and carriage returns (which
count as two bytes).
Customer Manually. The Customer associated with the QCR.
Supplier Manually The list of Suppliers associated with the QCR.
For example, Suppliers can initiate a SCAR if they
need to resolve issues in the process, products or
other areas.
Workflow Usually selected manually. If The name of the workflow used to move this QCR
you do not assign a Workflow | through the quality control process.
to a QCR it remains in the
Unassigned state.
You are prompted to select a
Workflow, if you move the
QCR to the next status
without assigning a Workflow.
You can change the workflow
selection as long as the QCR
is in the Pending status type.
Quality Select from a list. In the list, The default Quality Administrator.

Administrator

Departments appear first,
followed by individual user
names.

Note: If you prefer another QA over default QA, the
system displays a message "Quality Administrator
selected is not one of the defaults. The default Quality
Administrator list includes: Default QA UserName
(Userid), "

If you define the workflow to notify the default quality
administrator, the user groups or user in this field
receives notifications about the QCR. If this field is
blank, then the system sends notifications to every
quality administrator on the list. If the notification
definition in the workflow is blank, the system does
not send notifications.

Status Automatically, when created. Workflow status. If you do not select a workflow this
Updates as the QCR moves field displays the Unassigned status.
through the assigned
workflows.
Originator Usually automatically, when The originator or creator of the QCR.
created (with the default set
by the Agile PLM
Administrator).
Date Usually automatically, when The date you create the QCR
Originated created.
Date Automatically generated The date when the QCR moves to the Submitted
Submitted based on workflow status. status in the workflow.
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Date
Released

Automatically generated
based on workflow status.

The date when the QCR moves to the first released
status in the workflow.

Final
Complete
Date

Automatically when the QCR
enters the Complete type
status.

The date the QCR moves to the Complete status
type.

Preventive
Action

Usually manually; can contain
a default.

Maximum number of bytes is
set by the Agile PLM
administrator; can be up to
4000 bytes, including spaces
and carriage returns (which
count as two bytes).

A pro-active action taken to prevent the problem from
happening again. Applies only to CAPAs.

Root Cause
Analysis

Manually

Maximum number of bytes is
set by the Agile PLM
administrator; can be up to
4000 bytes, including spaces
and carriage returns (which
count as two bytes).

The root cause of the problem. Applies only to
CAPAs.

Planned Audit
Date

Manually. This field is visible

on setting the following pre-

requisite.

Note In Java Client, click
Admin tab. Navigate to
Data Settings > Classes
> Quality Change
Requests > Audits >
Cover Page > Planned
Audit Date.

Note Set Planned Audit Date
to Visible.

Ensure you hold read/modify
privileges for Planned Audit
Date attributes.

Date planned to audit the problem.

Audit Result

Usually manually, can contain
a default.

For example, when you
implement a CAPA, the
Quality Analyst performs an
Audit to ensure the CAPA
actually solves the problem. If
the fix for the problem is
validated, then the result is
pass. Otherwise it fails, and
the Quality Analyst updates
the Audit Result field.

Audit process result. The default setting for the audit
result is Pass/Fail. For more details, on other settings
contact the Agile Administrator.
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Product
Line(s)

Usually manually; can contain
a default.

List of product lines defined by the Agile
Administrator.

Updating the Cover Page of a QCR

After you create a QCR, you can modify it to provide additional information or edit any information

that has changed since its creation.
To update the Cover Page of a QCR (Java Client and Web Client):
Open the QCR you want to edit.
Click the Edit button.

Modify required fields. You can either enter text; use the drop-down lists or the palettes to edit

1.
2.
3.

4.

the QCR.

Click Save to save changes.

Note In Web Client, once you edit a QCR and save it, a message bar displays that the

changes have been successfully saved.

The Cover Page displays updates of the QCR.

Affected Items tab of a QCR

The Affected Items table lists the items affected by the QCR. The Affected ltems tab of a QCR includes
the Affected ltems tables and the PSR Items tables.

The table below lists and describes the default fields on the Affected Items tab.

Field Completed Indicates

Iltem Number Automatically, when created. Number of the Affected Item

ltem Automatically, when created. Description of the Item.

Description

Item Rev Manually The revision of the Affected Item in which you
find the problem.
For example, if the ltem has undergone five
revisions, and you identify the defect in revision
B, then Item Rev field displays B.
Note: You can add multiple copies of an ltem
with the same revision number to the Affected
ltems tab of a QCR.

Affected Site Automatically, when created. The site where you find the problem.

Image Automatically, when created. The presence of a PSR ltem.

The Affected Items tab page includes the Affected Items and the PSR Iltems table. The Views and
Personalize menus appear on both these tables.
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Note  The Personalize menu enables you to create and customize Views. Use the personalize
menu to create and save several views by defining filter conditions, and sort orders. You
can later choose the required view from the list of available views.

The PSR Items table lists Items referenced by problem reports and non-conformance reports
associated with this QCR. This table populates itself when the Relationship Rule has the QCR affect
the PSR.

o Associate a PSR with the QCR by adding the PSR to the QCR Relationships tab and adding a
Rule where the QCR affects the PSR.

o Associate a PSR with the QCR by adding the QCR to the PSR Relationships tab and adding a
Rule where the QCR affects the PSR.

@ Create a QCR from a PSR.

56 Agile Product Lifecycle Management



Chapter 3: Working with Quality Change Requests

The table lists the default fields on the PSR Item table of the Affected Items tab.

Field Completes Indicates

Item Number Automatically, when created Number of the Affected Item

ltem Automatically, when created Describes the Item

Description

Item Rev Manually The revision of the Affected Item in which
you find the problem.

Affected Site Automatically, when created The site at which you find the problem.

PSR Number Automatically, when created The number of the PSR associated with the
QCR.

Note  The Item Number field indicates the ¥ Ascending or * Descending order of the table,
depending on the sort order you choose in the Personalize menu.

Relationships tab of a QCR

The Relationships tab allows you to create relationships and dependencies between the current QCR
and other routable/lifecycle objects.

When you create a QCR from a PSR the system copies the:
o PSR to the Relationships table of the QCR.
7 QCR to the Relationships table of the PSR.

You can set the event trigger to move the PSR to a specific status in the workflow when the QCR
event occurs.

The Relationships tab of a QCR is similar to that of a PSR. See also: Relationships tab on page 35.

For details, see the Getting Started with Agile PLM guide.

Workflow tab of a QCR

The Workflow tab displays a flowchart of the workflow you selected on the Cover Page. An Agile PLM
workflow is a sequence of statuses that a routable object follows as it goes through the different
statuses in the quality control process. The status with the orange background (Web Client) or the
yellow background (Java Client) is the current status. The Signoff History table displays past
workflow and signoff information for the QCR.

The Workflow tab page includes the Views and Personalize buttons. For details on Views and
Personalize menus, see the Getting Started with Agile PLM guide.

Note Notice that the Default Audits and Default CAPAs workflow statuses are different from
those for other routable objects.
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The status of the audit workflow begins with Prepared state and that of the CAPA with the Identified
state.

Plan Audit

Schedule; Motify

Canduct Audit

Issue to the affected paries

Identify carrections; implement

Werify corrections

40444

Close audits; close PRs

The table below represents the status of a default CAPA.

Problem identified

CAPS opened
Imvestigatecd Root cause investigation
Snlytinn identified;
lig dizmizy iz change implemented
: Yerify changes and
BRI effectiveness
Clazed Close CARPA; close PSREs

For details, see the 'Routing objects with Workflows' chapter in the Getting Started with Agile PLM
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guide.

Submitting and Routing a QCR

You can submit QCRs using the Next Status button. The process is the same as for submitting other
routable objects. Before switching the QCR to a different status, always audit the routable object to
detect any errors that may prevent switching to a different status. When you submit a QCR, you also
notify the Quality Administrator by email. The Quality Administrator can also use the defined
searches in the Workflow Routings area of the Inbox or the Quality Searches folder to find recently
submitted QCRs.

For details, see the 'Routing Objects with Workflows' chapter in the Getting Started with Agile PLM
Guide.

Attachments tab of a QCR

You can reference files and attachments from the Attachments tab of a QCR. The Attachments tab of a
QCR is similar to that of the PSR. For details, see Attachments tab of a PSR on page 47.
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Managing Product Service Requests
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This chapter includes the following topics:

@ Approving/Rejecting a Product Service Request on page 61
& Closing a PSR on page 62

= Actions Menu in a PSR on page 62

o Audit status of a PSR on page 62

o Audit Release of a PSR on page 63

Approving or Rejecting a Product Service
Request

To approve or reject a PSR, you must be an Approver for the PSR and hold the PSR Administrator
role. See your Agile Administrator if you need additional privileges.

To approve a PSR:

Open a PSR. (Ensure that it is in the Review or Released status).

Click the Approve button above the tabs. The Approve to Review dialog appears.

Notice that the User field is pre-populated.

Enter Password as the User specified. This field is mandatory.

Select the Quality Analyst and Originator you want to notify.

Use the palette to add Reviewers.

Add Comments, if any.

Select the Send notification as urgent check box to mark the notification sent out because of this
action as "Urgent".

9. Click Approve.
10. Click Finish.

To reject a PSR:

1. Open aPSR. (Ensure that it is in the Review or Released status).

2. Click the Reject button located above the tabs. The Reject for Review dialog appears.
3. Enter Password to enter as the User specified. This field is mandatory.

4. Select the Quality Analyst and the Originator you want to notify.

© N G wDNPRE
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5. Use the palette to add Reviewers.
6. Add Comments, if any.

7. Select the Send notification as urgent check box to mark the notification sent out as a result of this
action as "Urgent".

8. Click the Reject button.
9. Click Finish.

Closing a PSR

To close a PSR (promote a PSR to the Complete status):
@ Close it manually (Provided you have appropriate privileges).

o Set a Rule on the Relationships tab of the PSR so that the status of the PSR is Closed on meeting
the conditions of that rule.

Actions menu in PSR

The Actions menu lists actions that you can perform on the PSR.

Bookmark: Saves the PSR as a Bookmark for future retrieval.

Subscribe: Subscriptions notify you of changes on tables or of attributes on the objects.
Save As: Creates and saves a copy of the current PSR in the same or a different subclass.
Delete: Deletes the PSR.

Send: Sends the PSR to other Users who have the necessary Roles and Privileges. An option to
send the notification as urgent is available.

Sharing: Allows Users to grant other users privilege access equivalent to his.

Copy URL to Clipboard: Copies the URL of the object to the clipboard, so that you can paste it
elsewhere.

Audit Status: Audits the status of an object to check if the workflow can progress further.

Audit Release: Audits if you can release the object with the existing workflow status.

View Workflows: Allows you to view the workflow states of the PSR.

Print: Prints the PSR.

Export: Exports the PSR to a delimited text file (CSV), a Microsoft Excel Notebook, or an XML file.
Create Quality Change Requests: Allows you to create Quality Change Requests on the PSR.

Audit Status of a PSR

Audits the status of a PSR, to check if the workflow can move to the next state. It is performed
automatically when the workflow of the PSR has to autopromote to the next state.

To audit the status of a PSR in Java Client:

1. Open a PSR you need to audit.

2. Click the Audit button at the top or right-click in the window; choose Audit Status from the menu
that appears.

62 Agile Product Lifecycle Management



Chapter 4: Managing Product Service Requests

3. The Audit Results for Audit Status dialog box appears. Correct errors, if any.
4. Click OK.

To audit the status of a PSR in Web Client:

1. Open a PSR you need to audit.

2. Click the Actions menu and choose Audit Status.

3. A message bar displays the message to correct errors if any.
4. Click Close.

Audit Release of a PSR

An Audit Release is performed automatically when the PSR is promoted to the release state. The Audit
Release validates if the settings of a PSR match Release status settings.

(For example: Entry Required fields, Status matching criteria)

You can release a PSR by using the Next Status button on the Workflow tab. If you set the
AutoPromote property of the preceding Review status type to Yes, then you release the routable
object (automatically when all the approvers have approved the change).

Before you release a PSR, you need to audit it and pass the audit release. The system will validate
the following audit for each status level:

o For the Pending, Review, Released, and Complete status:

Required fields for the current status level. (Your Agile Administrator determines the required fields
in the workflow property settings.)

o For the Review status:

Checks approval of all Approvers.
o For the Released status:

Checks all the current release audit rules.

For details on how to release a PSR, see the 'Routing Objects with Workflows' chapter in the Getting
Started with Agile PLM guide.

To audit the PSR for release in Java Client:

1. Open the PSR you want to audit for release.

2. Click the Audit Release button or right-click in the Agile Java Client window; from the menu that
appears, choose Audit Release. The Audit Results for Audit Release dialog box appears.

3. Correct errors, if any and audit again.
4. Click OK to close the Audit Results dialog box.

To audit the PSR for release in Web Client:
1. Open the PSR you want to audit for release.
2. Choose Actions > Audit Release.

3. Correct errors, if any and audit again.

4. Click Close.
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This chapter includes the following topics:

o Approving/Rejecting Quality Change Requests on page 65

o Closing a QCR on page 66
B Actions Menu in a QCR on page 66

o Change Order in a QCR on page 66

Approving or Rejecting Quality Change
Requests

If the QCR specifies you as an Approver, then you have to verify the audit or corrective action for a
specific item. For details, see the Getting Started with Agile PLM guide.

You need to hold necessary privileges and meet the following conditions to approve or reject a QCR.
= The QCR needs to be in review or released type status

o You need the necessary privilege to approve or reject it in that status

o You need to be on the QCRs list as an approver or observer

To approve a QCR in the Web Client;

Open the QCR you want to approve.

Click the Approve button. The Approve wizard appears.

In the Password field, enter your password.

Select the check boxes to notify the Originator, Quality Analyst, and Reviewers.
You can also notify users or user groups that you have approved the QCR.
Click the Search palette and select the users you want to notify.

In the Comments field, enter approver comments. Comments are not mandatory. To enable
Comments, you need to set Comments for Rejection to Allow in the Java Client.

For details, see the 'Workflow' chapter in the Agile PLM Administrator guide.
8. Click Approve.

No aMwDdPE

You can reject QCRs if they are not appropriate. For example, if you are a Quality Manager, and feel
the corrective action taken by your team is not appropriate, you can reject the action.

To reject a QCR in the Web Client:
1. Open the QCR you want to reject.
2. Click the Reject button. The Reject wizard appears.
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In the Password field, enter your password.
Select the check boxes to notify the Originator, Quality Analyst, and Reviewers.
Click the Search palette to select users you want to notify.

In the Comments field, enter Approver comments. Comments are not mandatory. You need to
set Comments for Rejection to Allow in the Java Client.

For details, see the 'Workflow' chapter in the Agile PLM Administrator guide.
7. Click the Reject button.

Closing a QCR
To close a QCR (promote a QCR to the Complete status):
o Close it manually (provided you have the appropriate privileges).

I

o Set a Rule on Relationships tab of the QCR so that the status of the QCR is Closed on meeting the
conditions of that rule.

Typically, when you release a Change or an ECO related to a QCR, the Quality Administrator
determines if you can resolve and close a QCR.

Actions Menu in a QCR

The Actions Menu lists actions that you can perform on the QCR.

Bookmark: Saves the QCR as a Bookmark for future retrieval.

Subscribe: Subscriptions notify you of changes on tables or of attributes on the objects.
Save As: Creates and saves a copy of the current object in the same or different subclass.
Delete: Deletes the QCR.

Copy URL to Clipboard: Copies the URL of the object to the clipboard, so that you can paste it
elsewhere.

Audit Status: Audits the status of an object to check if the workflow can progress further.

Audit Release: Audits if you can release the object with the existing workflow status.

Print: Prints the QCR.

Export: Exports the QCR to a delimited text file (CSV), Microsoft Excel Workbook or to an XML file.

Send: Sends the QCR to other Users who have the necessary Roles and Privileges. An option to
send the notification as urgent is available.

Sharing: Allows Users to grant other users privilege access equivalent to his.
Create Change: Allows you to create a Change directly from the QCR.

View Workflows: Allows you to view the workflow states of a QCR.

Change Order in a QCR

You can create a change directly from the QCR, which allows you to release a change order to fix
the problem. The Change you create from the QCR appears in the Relationships tab of the QCR.
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To create a Change from a QCR in Java Client:

1.

2
3.
4

5.

In the Cover Page of a QCR, right-click and select Create Change.
Select a Change object type from the Type list - MCO, ECO, ECR, Deviation, or Stop Ship.

In the Number field, type a number or click the AutoNumber 2 button to generate a number.

The Add Affected Items to Change table lists all Affected Items of QCR and PSR. Select items
from the list of Affected Items and PSR Items. If an Item is already associated with a Change, it
still appears in this list so that you can initiate multiple changes related to one Item. The list
shows unique items (if the item shows up in the Affected Items and PSR Items, then the list
displays the item only once).

Click OK.

Agile Java Client creates the Change and adds it to the Relationships tab of the QCR. The system
copies the Items selected to the Affected Items tab of the Change (This allows you to separate the
QCR into multiple Changes, each containing different Items).

To create a Change from a QCR in Web Client:

Open the QCR and select Actions | Create Change menu option.

In the Create New dialog, select a Change object type from the sub-class list - MCO, ECO,
ECR, Deviation, or Stop Ship.

In the Number field, type a number or click the Autonumber 123

The Date Originated field is pre-populated.
Click the Search palette to add Versions.

Use the Search palette to add Affected ltems. Select and double-click an object to move it to the
Affected Items field.

Click Close.
Click Save.

button to generate a number.

Agile Web Client creates the Change and adds it to the Relationships tab of the QCR. The system
copies the items selected to the Affected ltems tab of the Change (This allows you to separate the QCR
into multiple Changes, each containing different Items).
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Appendix A
Deleting Agile Objects

Java Client and Web Client support “soft” and “hard” deletes for many Agile object classes. When
you soft-delete an object in the database, it is not permanently deleted. A soft-deleted object is
marked “Deleted” in the database, and its object number or name is reserved. You cannot create
another object with the same type and number or name as a soft-deleted object.

When you run a search, soft-deleted objects do not appear in the search results table. To locate
soft-deleted objects, you must run the predefined deleted object searches in the Recycle Bin Searches
folder.

Note  You have access to the Recycle Bin Searches folder if Recycle Bin Searches is included in the
Searches field of your user profile. If you have the appropriate privileges, you can edit
your user profile and add Recycle Bin Searches to the list of searches in the Searches field.
If you do not have the appropriate privileges to modify the Searches field in your user
profile, ask the Agile administrator to modify your user profile.

A hard-deleted object is permanently removed from the database.
Caution You cannot undelete a hard-deleted object.

In order to soft-delete, hard-delete or undelete an Agile object:
o You must have the appropriate Delete or Undelete privileges for that object.
o All relationships and subscriptions must be removed.

o The object must meet any additional conditions that determine whether it can be deleted or
undeleted.

In general, if deleting or undeleting an object would cause the compromise of data integrity, the
delete or undelete action is disabled.

Notes about Deleting PSR or QCR Objects

Before you can delete a Product Service Request (PSR) or Quality Change Request (QCR) object,
it must meet the conditions described below.

o The Agile administrator has assigned to you a role that has the appropriate Delete privileges.

o All relationships and subscriptions have been removed.

= The PSR or QCR is at the Pending status type or the Unassigned status.

o You have Discovery and Read privileges for any items on the Affected Items table; otherwise,
you cannot delete the PSR or QCR.

Note To delete a PSR or QCR that has already been released, you must first unrelease it. You
need the appropriate privileges to unrelease a PSR or QCR by using the Workflow tab to
switch it to a different status.

You cannot delete a PSR if:
o |t appears on a QCR's Relationships tab.

o Itis currently part of a corrective action process. Remove the PSR from the QCR and then
delete the PSR.
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o It appears in the Related PSR tab of another PSR.

o |tis currently part of a larger problem. Remove this PSR from the parent PSR and then delete
it.

o |t appears on the Related PSR tab.

o Itis being used to aggregate multiple problems. Remove the related PSRs and then delete it.

You cannot delete a QCR if:

o It has any PSRs on the Relationships tab.

= If the corrective action process contains Problem Reports. Remove the PSR from the QCR and
then delete the QCR.

= It has any Changes on its Relationships tab.
o If the corrective action process is already routed through engineering changes. Remove the
Changes from the QCR and then delete the QCR.

This section contains the following topics:

o Soft-Deleting an Object on page 70
o Undeleting an Object on page 70
®  Hard-Deleting an Object on page 71

Soft-Deleting an Object

When an object is soft-deleted, it is no longer available for use. However, until it is hard-deleted, its
number or name is reserved in the Agile database and cannot be reused.

To soft-delete an object in Java Client:
1. Select and open the object you want to delete.

2. Click the Delete button X_, and respond Yes to the confirmation prompt.
The object is soft-deleted.

To soft-delete an object in Web Client:
1. Select and open the object you want to delete.
2. Choose Actions > Delete, and respond OK to the confirmation prompt.

The object is soft-deleted.

See also: Deleting Agile Objects, Undeleting an Object on page 70, and Hard-deleting an Object
on page 71.

Undeleting an Object

If you have the appropriate privileges, you can undelete soft-deleted objects.

To undelete an object in Java Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.
2. Open the deleted object you want to restore.

3. Click the Undelete button .
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To undelete an object in Web Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.
2. Open the deleted object you want to restore.

3. Choose Actions > Undelete.

Note  You can click the Navigator button in the search results table to display the search result
object links in the left pane % NAVIGATOR drawer.

See also: Deleting Agile Objects, Soft Deleting an Object on page 70, and Hard-deleting an Object
on page 71.

Hard-Deleting an Object

Soft-deleted objects still exist in the database. To remove an object permanently, you must hard-
delete it. While an object is still only soft-deleted, you can undelete it. Run the appropriate Deleted
object search from the Recycle Bin Searches folder.

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client:
1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

2. Open the object.

3. Click the Delete Object button 'X-, and respond Yes to the confirmation prompt.

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Web Client:
1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

Select the one or more object rows in the search results table.

Click the Delete button.

In response to the warning prompt, choose Continue, then click Finish.

Or, you can hard-delete one object at a time:

ok wn

* Open the object.
®* Choose Actions > Delete, and respond OK to the confirmation prompt.

Note  You can click the Navigator button in the search results table to display the search results
object links in the left pane % NAVIGATOR drawer.

See also: Deleting Agile Objects, Undeleting an Object on page 70, and Soft Deleting an Object on
page 70.
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